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Poglavije 1

Upoznavanje sa Dreamweaver MX-om

U ovom poglavlju naucicete:

1. Sta je Dreamweaver MX i koja je njegova osnovna namena
2. Osnovne karakteristike radne povrsine i alata

1.1 Sta je Dreamweaver i njegova osnovna namena

Dreamweaver MX je program za izradu web strana, koji omogucava vizuelno projektovanje
i uredivanje, kao i neposredno pisanje HTML koda. Takode omogucava izradu dinamickih
web aplikacija koriste¢i serverske jezike kao Sto su ASP, ASP.NET, COLD FUZION,
MARKUP LANGUAGE (CFML), JSP | PHP.

Dreamweaver skracuje vreme izrade web prezentacije, a ima i alatke za njihovo menjanje i
odrzavanje. Ovaj program je dosta fleksibilan jer i napredne tehnike &ini pristupacnim i
olakS8ava njihovo koriS¢enje. Objedinjavanjem velikih moguénosti projektovanja i
programiranja pruza mnostvo pogodnosti i poCetnicima i iskusnijim korisnicima.

Ovaj tekst je namenjen korisnicima koji imaju malo ili nimalo iskustva u kori¢enju
Dreamweavera i u njemu se nece govoriti o pravljenju sloZenih aplikacija i dinamickih web
prezentacija u kojima se koriste baze podataka, specificno ponaSanje servera i Web
aplikacija, jer je za njih neophodno poznavanje gore navedenih serverskih jezika.

| pored svih korisnih stvari koje nudi (a vide¢ete da ih ima dosta) Dreamweaver, ne sme se
zaboraviti i ona takode veoma vazna stvar a to je detaljno planiranje sajta, jer sigurno ste
se vec dosta puta susreli sa sajtovima Ciji je fokus usmeren na alate i tehnologije, natrpane
Java Apletima, Java Script efektima, raznim animacijama i zvucima, ali nazalost, bez

pravog logi¢kog sadrzaja.
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1.2 Radna povrsina i alati

Pre nego Sto pocnete da pravite Web strane, treba da se upoznate sa radnom povrSinom
programa i njegovim alatima. Prilikom prvog pokretanja Dreamweavera prikazace se
prozor dobrodoslice sa informacijama za nove korisnike, kao i niz novih moguc¢nosti za one
koji vec poznaju program. Ako vam nekad kasnije zatreba ovaj prozor do njega dolazite
kada izaberete opciju Welcome iz Help menija.

Macromedia Dreamweaver MX

Welcome to Dreamweaver MX!

Select a category 1o learn more:

New Users:
Design Code Develop

Returning Users:
What's New?

Slika 1.2.1 Izgled Welcome prozora

Takode Dreamweaver MX daje mogucnost izbora (slika 1.2.2) jednog od dva ponudena
izgleda radne povrsine, novu, integrisanu povrsinu u kojoj su svi prozori i paneli integrisani
u jedan Siri aplikacioni prozor, ili radno okruZenje ve¢ videno u prethodnoj verziji programa
(Dreamweaver 4).

Po otvaranju Dreamweavera sa novim (MX) izgledom radne povrSine susre¢emo se sa
slede¢im elementima (slika 1.2.3.):

- Insert Bar, sadrzi tastere za unos razliCitih tipova objekata, kao Sto su slike,
tabele, layer-i u dokument. Svaki objekat je predstavlien HTML kodom Koji
omogucava podeSavanije razliitih atributa.

- Document Toolbar, sadrzi tastere i pop-up menije za podeSavanje izgleda
prozora dokumenta. Inae u Dreamweaveru postoje tri nacina prikazivanja, to su
Design View, Code View i Split Design and Code. Dugmad za menjanje tih prikaza
nalaze se na levoj strani ovog toolbar-a.
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Document toolbar sadrZi i neke osnovne operacije kao sto je preview u browseru.

Workspace Setup

Pleaze chooze the workzpace layout you're most comfortable with. ou can switch
lapoutz later in Preferences.

A SNl e -

pooooooDon

| —— T
| — - o T

(%) Dreamweaver My Workspace () Dreamweaver 4 Workspace

[1HomesSite/Coder-Style

Slika 1.2.2 Izbor radne povrSine
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Slika 1.2.3 Dreamweaver MX radna povrsina

- Document Window, prikazuje tekuci dokument i rad na njemu. U donjem levom
uglu prozora dokumenta nalazi se bira HTML oznaka (Tag Selector), u njemu se
hijerarhijski prikazuju HTML oznake koje pripadaju trenutno izabranom elementu.
Pocetna HTML oznaka je uvek <body>.

- Property Inspector, omoguéava menjanje osobina selektovanih objekata ili
teksta. Svaki objekat posjeduje razliCite osobine.

- Panel Group, je grupa panela sa desne strane: Design, Code Application, Files i
Answeres. Da bi otvorili zeljeni panel kliknite na strelicu sa leve strane imena
panela.

-  Site Panel, omoguc¢ava upravljanje fajlovima i folderima koji ¢ine va$ sajt. Takode
obezbeduje i pristup fajlovima na hard disku, sli¢no kao kod Explorera (drvo).

Kratak opis menija:

- File i Edit meni, sadrze standardne komande kao $to su new, open, save, save
as, copy, cut i paste. File meni sadrzi i razli¢ite komande za prikaz i rad na
teku¢éem dokumentu (Preview u Browseru, Print Code). Edit meni ukljucuje
komande za selekciju i pretrazivanje (Select Parent Tag, Find And Replace) i
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omogucava pristup editoru za precice na tastaturi. Pristup preferencama je takode
iz Edit menija.

View meni omoguéava izbor razli¢itih prikaza dokumenta (Design View, Code
View) i prikazivanje i skrivanje raznih elemenata strane i Dreamweaver alata.
Insert meni predstavlja alternativu Insert Bara. SluZi za dodavanje objekata u
dokument.

Modify meni daje moguénost promene karakteristika selektovanog elementa
stranice. Koriste€i ovaj meni mogu se editovati tag atributi i menjati elementi
tabela.

Text meni obezbeduje lako formatiranje teksta.

Commands meni omogucava pristup razlicitim komandama, ukljuCujuci i one za
optimizaciju slika sa Macromedia Fireworks-om.

Site meni pruza komande za kreiranje, otvaranje i editovanje sajtova.

Window meni omoguc¢ava pristup svim panelima, inspektorima i prozorima u
Dreamweaveru.

Help, standardno uklju¢uje Help sistem za koris¢enje Dreamweavera.
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Poglavlje 2

Kreiranje Web sajta i Web strane

U ovom poglavlju naucicete:

1. Da kreirate lokalni Web sajt
2. Da kreirate, imenujete i sacuvate Web stranu
3. Da zadate Web Browser

2.1 Kreiranje lokalnog Web sajta

Za pocetak objasni¢emo pojam sajta. Re¢ sajt ima viSe znacenja:

- Website, skup strana na serveru kojima pristupa posetilac preko svog browsera.

- Remote site, skup fajlova na serveru koji ¢ine Web sajt, uglavhom gledano sa
pozicije autora samog sajta.

- Local site, fajlovi na lokalnom ra¢unaru identi¢ni onima na remote sajtu. Sa njima
se radi na raCunaru, a potom se prebacuju na server.

- Site definition, u Dreamweaveru oznalava karakteristike lokalnog sajta sa
informacijama o tome kako lokalni sajt komunicira sa remote sajtom.

Naj¢e8ce koriS¢en nacin kreiranja Web sajta je kreiranje i rad sa web stranama, na
lokalnom raCunaru, a zatim prenos kopija tih strana na web server kako bi one postale
dostupne javnosti. Takav rad i ovde se podrazumeva.

Sam postupak kreiranja je sledeci:
1. 1z menija Site izaberite New site. Pojavi¢e se okvir za dijalog Site definition, Kkoji
nudi moguénost izbora osnovnog (Basic) ili naprednog (Advanced) postupka
kreiranja sajta. Izaberite Basic i kliknite next. (slika 2.1.1)
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aite Deninition for Unnamed Site 1

Basic | Advanced |

Site Definition

Editing Files

A site, in Macromedia Drearweaver b, iz a collection of fles and folders that coresponds to a
website on a server

“What wousd pou like o name pour ite? ‘L?f

_I nnamed Sike 1

Examplec MySite

Slika 2.1.1

2. Sada upiSite ime vaSeg sajta i predite na sledeci korak.

3. Dreamveawer sada pita da li zelite da radite sa serverskim tehnologijama (ASP,
ASP.NET, PHP, JSP...). Izaberite Ne, jer ¢e ovde biti razmatrani samo staticki
sajtovi. Definiciju samog sajta uvek mozete izmeniti kada izaberete iz menija
Site/Edit Sites...(slika 2.1.2)

Site Definition for Unnamed Site 1

| Basic | advanced |

Site Definition

Editing Files, Part 2

. [ yous weant o work with T§erva technology such a3 ColdFusion, ASP.MET, ASF. JSP. or PHP?

| ) Mo, | dio ot weanil bo usE a server lechnolony.
0 %es, | want bo use & server technology,

Slika 2.1.2

4. Program vas pita kako Zelite da radite sa datotekama vaSeg sajta. Pritisnite radio-
dugme : 'Edit local copies on my machine, then upload to server when ready.
(Recomended)'. (slika 2.1.3)
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Site Definition for Unnamed Site 1

| Bash: . | Advanced

Site Definition

Editing Files, Part 3

Howr do o ward o weork, wakh yoar fles during development?

(%) Eclt bocal copées on my maching, then upload to server when ready [recommended)
[ () Edit directy on server using local nebwork
Y Edit directy on serves usng FTP or RDS

and Se

Slika 2.1.3

5. Sada treba da upisete gde zelite da smestite datoteke saijta, ili pritisnite folder
ikonicu desno od polja za unos teksta ako ste ve¢ prethodno odredili mesto za
sajt. Taj izabrani folder se naziva lokalni korenski direkrorijum i pomoc¢u njega
Dreamweaver odreduje putanje dokumenata, slika i hiperveza vaseg sajta.

6. Na slede¢em koraku vas program pita 'how do you connect to your remote server'
S obzirom da se radi o lokalnom sajtu izaberite 'None'. (slika 2.1.4)

Site Definition for. Unnamed Site 1

| Baskc | advenced |

Site Definition

Sharing Files

[ _H-::w do you connect to your remate sErver? :
| Local/Network ol

FTP in’?

SourceSafe Database
, WebDAV

Slika 2.1.4
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7. Pritisnite next da biste presli na sledeéi korak. Pregledajte podatke koje ste do sada
zadali i pritisnite dugme Done da bi zavrsili kreiranje sajta. Novokreirani sajt mozete

videti u sajt panelu. (slika 2.1.5)

Site | Assets

File« Edit. Yiew. Sites

Sajt

Slika 2.1.5

2.2 Kreiranje nove Web strane

Novokreirani

oa C |O & v %| E

|Unnamed Site 1 % | | Local Yiew

W

lako Dreamweaver otvara nov dokument ( stranu) bez naslova, ¢esto ¢ete sami morati da

pravite nove strane, i to ¢e te Ciniti na sledeéi nacin.

Izaberite New iz opcije File. Otvoriée se okvir za dijalog New document sa dve kategorije
General i Templates. Na kartici General nudi vam se mogucnost izbora neke od ponudenih
predizajniranih strana, ali preporu¢ujemo izbor 'prazne’ HTML strane (kategorija Basic

Page, opcija HTML). (slika 2.2.1)

-10 -
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MNew Document EI
General | Templales
Categony: Basic Page: Preview: :
5 |
Dynarnic Page @ HTML Template
Template Page @ Library Item
Other & css :
255 Style Sheets @ JavaScripk [
Framesets @l AL « Mo Previews |
Page Designs |
Page Designs (Accessible) [
|
|
Description: [
HTHML docurnent ‘
|
[(IMake Document XHTML Camgliant !
Help ] [ Preferences... ] Get More Content, | Create .\J [ Cancel |
&

Slika 2.2.1 Kreiranje nove strane

Novi dokument bez naslova (Untitled-1), koji se automatski otvara kada pokrenete
Dreamweaver je HTML strana. Vrstu tog dokumenta moZete promeniti kada pritisnete
dugme Preferences u istoimenom prozoru.

Na dnu okvira New Document nalazi se opcija Make Document XHTML Compliant,
Koja je veoma korisna jer ¢e vasa strana biti kompatibilna sa starijim i novijim verzijama
HTML-a.

Kreiranu stranu moZete saCuvati tako Sto izaberete opciju Save iz menija File.(slika 2.2.2)
Naravno, dacete joj ime i saCuvati u lokalnom darektorijumu sajta. Preporucljivo je snimiti
datoteku pre stavljanja bilo kakvog teksta ili slika, jer ée tada sve putanje koje se odnose
na te elemente biti propisno formirane.

Napomene: Davanje imena stranama koje Ce se koristiti na Web serveru razlikuje se od
imenovanja strana za koriS¢enje na lokalnom racunaru. U zavisnosti od operativhog
sistema koiji koristi server, struktura imena se razlikuje (Kod Unix-a razlikuju se mala i
velika slova). Zato je preporuka koristiti samo slova (A-Z) i brojeve (0-9).U imenima
datoteka takode ne sme biti razmaka. Ako je neophodno razdvoijiti re€i upotrebite potcrtu ili
crticu.

Ne smete koristiti specijalne znakove kao sto su: %,*#,/.

-11 -
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Ne pocinjite imena datoteka brojkom.
Vodite racuna da ime strane ne bude suviSe dugo, jer se ime strane postaje sastavni deo
URL adrese koju korisnik mora otkucati da bi pristupio strani.

Unnamed Sike 1 % | | Local View w

=l @ Site - Unnared Sike 1 (D:\Dacurne
o

Slika 2.2.2 Novokreirana web strana

Postoji jo$ jedan nadin kreiranja nove strane, a to je da uradite desni klik na sajt u sajt
panelu i da izaberete opciju New, gde se opet susrecete sa prozorom New Document.
(slika 2.2.1)

Davanje naslova Web strani

Svaki HTML dokument mora imati naslov, koji prvenstveno sluzi za identifikaciju i vidi se
na naslovnoj traci browsera. Taj naslov takode postaje ime Bookmarka koji se prilaze uz
Web stranu. Zbog toga treba izabrati kratke izraze koji najbolje opisuju namenu same
strane. Ako zaboravite da imenujete stranu Dreamweaver &e je nazvati Untitled document.
Najzad, strani dajemo ime upisujuéi ga u polje Title u Document Toolbar-u. Ukoliko
Document Toolbar nije vidljiv moZe se pronaéi u biranjem opcije Document iz Toolbars
opcije menija View (slika 2.2.3).

[Commu:-nTLagnutm[TableerramesTFnrmsrTemplates[Charactereredia Head Scriptr.ﬁ.pplicatinnl

ONCIEEE|EL®0 o=

& ge _él_g ZE | Tile: | Untitled Document f\\@' @ C ¢ ) E
T

Slika 2.2.3 Imenovanje Web strane
Davanje boje pozadine

U Dreamweaveru se boja pozadine lako menja pomocu specijalne palete boja za Web
(Web — safe Color Pallete). Na toj paleti ima 216 boja. Da bi promenili boju izaberite opciju
Page Properties iz menija Modify. U ovom prozoru pritisnite polije sa bojom do opcije
Background. Prikazace se paleta boja, a pokaziva¢ misa ¢e se pretvoriti u pipetu. Dovedite
pipetu iznad Zeljene boje. Mozete primetiti da se boja u HTML-u definiSe heksadecimalnim
brojem, koji opisuje koli¢inu njene crvene, zelene i plave komponente. Sada oznadite boju i
pritisnite dugme Apply. (slika 2.2.4)

Slika na pozadini strane

Na pozadinu se obi¢no stavlja slika &ijim se kopijama poplo€ava cela strana. Strana moze
imati definisanu i boju i sliku za pozadinu.U prozoru Page Properties pritisnite dugme
Browse do polja Background image i izaberite Zeljenu sliku. Preporucljivo je staviti sve
slike koje ¢e se koristiti za izradu strane u jedan folder lokalnog korenskog direktorijuma.
(slika 2.2.4)
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Odredivanje boje fonta

Kada ste izmenili boju pozadine, ili stavili sliku na nju, pozeljno je da prilagodite boju slova
teksta pozadini. Prilikom biranja boja za dokument izaberit one kombinacije koje se dobro
slazu i koje su dovoljno kontrastne. Odabir boje teksta se takode vrSi u okviru Page
properties prozora u polju za boju teksta. (slika 2.2.4)

—_—
=
-

Title: E-Llntitled Dracument

Backgruundlmage:i |[ Browsze. .. ]

Test:
Links:
Lett b argin:

Top Margir:

Diocument Encoding:

|

T
Tracing Image: l | Browse. ..

Image Tranzparency: 100%

Tranzparent Opaque

Document Faolder:

Site Folder: D:\Documents and Settingzh T ikihzekih

Slika 2.2.4 Page properties

2.3 Zadavanje Web Browsera

Tokom razvoja Web strana bi¢e neophodno da stalno proveravate izgled vaseg rada u
razliCitim Web browserima, kao Sto su Netscape, Internet Explorer, Opera... Ono $to vidite
u prozoru Dreamweavera samo je priblizno jednako stvarnom izgledu prezentacije. Svaki
browser prikazuje Web strane na manje — vise razli€it nacin. S obzirom da svi posetioci
nece koristiti isti ¢ita¢ za gledanje vaSeg sajta bilo bi najbolje, ako je to moguce, prilagoditi
strane sajta bar onim naj¢es¢ée koris¢enim browserima.

Izaberite File — Preview in Browser — Edit Browser List. Otvori¢e se prozor za dijalog
Preferences i prikazati €itaCe izabrane za proveru. Dreamweaver ¢e automatski prikazati
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spisak €itaca instaliranih u raCunaru. Tu mozZete odrediti koji ¢e browser biti primaran a koji
sekundaran, i eventualno zadati pe€icu na tastaturi za pojedine browsere. Ako Zelite da
dodate nov Cita¢ pritisnite dugme +. (slika 2.3.1)

Categary Prewview in Browser
| General [
Accessibility - = ]
Code Coloring Brovisers: ﬂ J
Code Format - "
Code Hints ;IEXPLDHE.EXE F12
Code Rewriting
55 Styles
File Tupes / Editars
Fonts
Highlighting
Invizible Elements
Lapers
Laﬁnut View [] Secondary Browser
Mew Document
Panels

| OpErd. EXE

Defaults: [ ] Primary Erowser

Options: [v] Preview Using Temparary File

Presigw in Browser

Slika 2.3.1 Izbor Browsera
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Poglavlje 3

Rad sa tekstom

U ovom poglavlju naucicete:

Da pravilno upisujete i formatirate tekst u Web strani
Rad sa fontom

DefiniSete i primenite HTML i CSS stilove

Dodate specijalne znake, horizontalne linije i datum

) (3 [

3.1 Upisivanje i formatiranje teksta

Tekst se naravno, upisuje neposredno u dokument. Ali, da bi sve izgledalo kako treba,
preporuéljivo je pridrzavati se nekih pravila.

Kada napiSete naslov, moguce je formatirati ga izborom jednog od ponudenih Sest formata
za naslov (naslov prvog nivoa, Heading 1, ima najve¢a slova), koji se nalaze u panelu
Properties (slika 3.1.1). Kada pasusu dodate HTML oznaku naslova, automatski se ispod
njega dodaje odreden prazan prostor &iju veli¢inu ne mozete menjati. Preporucljivo je da
prvi naslov na strani bude jednak nazivu same strane.

Kada ste formatirali naslov pritisnite Enter. Tada dodajete novi red koji ozna¢ava pocetak
novog pasusa, $to mozete i videti u Tag selectoru gde je dodata oznaka pasusa <p>. Za
obiCan tekst koristi se, po pravilu, format pasusa. Ne zaboravite da posle nekog vremena
saCuvate vas$ rad.

Farmat | Mone w | /2 | Default Font v Size | Mone s E B I IE=E=E=E
Lirk. | Mone N . v 235 'I:arget I= T A= 2=
Faragraph
7 »
Heaing - ; Text Text
Heading 3 Unorderad List Ordered List
abeseltih Outdent Indent

Slika 3.1.1 Formatiranje teksta

Ako hocete da predete u novi red a da pritom ne bude dodatnog razmaka izmedu
prethodnog i novog reda pritisnite Shift + Enter. To znaci da ste ostali u istom pasusu.
Oznacavanjem bilo kog reda nekog pasusa i njegovim formatiranjem, formatirate celi
pasus.

Moguénosti za poravnanije teksta su standardne (levo, desno, centralno i obostrano).
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Osim poravnanja, pasuse teksta, mozete i da uvuCete od margina. Za to se koriste
dugmad Text Indent i Text Outdent u panelu Properties. (slika 3.1.1)

U Dreamweaveru mozete praviti dve vrste lista (spiskova), uredene liste (Ordered List) i
neuredene (Unordered List), liste nabrajanja. Da bi napravili (ne)uredenu listu, poterbno je
selektovati Zeljeni deo teksta i pritisnuti dugme (Un)Ordered List na Property panou.(slika
3.1.1). Semu numerisanja uredene liste (number, roman, alfabet) moguée je odabrati
pomodu List Item opcije na property panou. Ista opcija sluZi za modifikovanje neuredene
liste (bullet, square).Cesto je potrebno poslednje formatiranje ponoviti na slede¢im
pasusima ili drugom izabranom tekstu. To je najlakSe uraditi koriste¢i naredbu Repeat, iz
menija Edit, ili preCicom sa tastature Ctrl + Y.

Dodavanje teksta iz drugih dokumenata

Tekst se strani moze dodati kopiranjem iz drugog dokumenta. Dreamweaver moze da
otvori datoteke napravljene u programima za obradu teksta ukoliko su snimljene kao Cist
tekst (.txt). Te datoteke se uvek otvaraju u novom prozoru, i to uvek u prikazu Code View,
tako da ih odatle mozete kopirati na vasu stranu.

3.2 Rad safontom

Web strane ¢e biti zanimljivije i lakSe ¢e se Citati ako promenite font kojim se prikazuje
tekst. Morate voditi racuna o ¢injenici da korisnici mogu da menjaju velicinu prozora i fonta
kao i boju slova. Izgled teksta se menja od korisnika do korisnika. U HTML-u ne mozete da
utiCete na prored teksta i meduslovna rastojanja.

Font cele strane ili izabranog dela teksta se moze menjati na viSe nacina, direktno na
panou Properties u padajucoj listi Font ili desnim klikom izabirajuci opciju Font, Edit Font
List. (slika 3.2.1)

Da bi posetilac video stranu onako kako ste je napravili mora na svom racunaru imati
instaliran font koji ste zadali. Kombinacije instaliranih fontova ¢ine da ¢ita¢ prikazuje tekst u
drugom fontu. Ako prvi font u spisku fontova nije instaliran, browser ¢e pokuSati da
upotrebi drugi a na kraju tre¢i. Ako ni jednog od tih fontova nema na korisnikovom
racunaru, tekst se prikazuje u podrazumevanom fontu CitaCa. Kombinaciju fontova mozete
da promenite kad izaberete opciju Edit Font List. |zaberite kombinaciju fontova i zatim
jednu od sledecih opcija:
- da biste dodali ili uklonili font, izaberite font i pritiskajte dugmad sa strelicama koje
premestaju fontove izmedu spiskova chosen (izabrani) i available (dostupni).
- da biste dodali ili uklonili kombinaciju fontova pritiskajte dugmad sa znakovima + i -
u gornjem levom uglu okvira.
- ako zelite da dodate font koji nije instaliran u sistemu upiSite ime fonta u polje
ispod liste available fonts, i pritisnite dugme sa dvostrukom strelicom.

U HTML-u su moguc¢nosti menjanja veli¢ine fonta ograni¢ene. U panelu Properties
izaberite listu veliCina fontova Size. VeliCine su poslagane od +1 do +7 i od -1 do -7. Ako
izaberete broj bez predznaka zadali ste apsolutnu veli¢inu fonta, a biranjem broja sa
predznakom + ili- zadajete relativnu veli€inu fonta, npr. broj +1 daje font za jedan broj vedi
od njegove osnovne veli¢ine. Podrazumevana osnovna veli€ina fonta u browseru je 3.
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Edit Font List

ﬂj Farnt List: ﬂ j
| Times Mew Roman, Times, serif =
Couner Hew, Courier, mona .

Georgia, Times Mew Roman, Times, serif

Yerdana, Anal, Helvetica, zans-zerif
eneva, Anal, Helvetica, zans-sernf

I' Add fontz in lizk Below |

_Ehu:usen Fants: _ _ Avallable Fonts: _
| ' [ A&rial Al
Anial Black =

Arial Marrow

BeolMFO
| Book Antiqua >

il ]

Slika 3.2.1 Rad sa fontom

Takode u Dreamweaveru se boja teksta lako menja. Na panelu Properties pritisnite dugme
Text Color i izaberite zeljenu boju.

Sve boje koje upotrebite se Cuvaju u panelu Assets koji se nalazi u panelu File. Najcesce
koris¢ene boje snimite u direktorijum Favorites.

3.3 HTML i CSS stilovi

Da bi Web strane bile zanimljivije ispisuju se raznim fontovima. Oblik, veli€inu i boju slova
mozete lako menijati, ali ako hoéete da upotrebite nekoliko kombinacija boja, oblika,
veli¢ina slova za celi sajt te kombinacije parametara morali bi ste da pamtite od strane do
strane. HTML stilovi Cuvaju formatiranje slova i pasusa izabranog dela teksta, koje
mozete ponovo da  upotrebite u drugim pasusima istog dokumenta i u drugim
dokumentima. Primenom ovih stilova dokumenti ¢e izgledati ujednacenije, a postupak
formatiranja teksta Ce biti znatno ubrzan. Ako izmenite ili obriSete neki stil to nece uticati na
izgled teksta ve¢ formatiranog tim stilom.

U panelu Design naci ¢e te karticu HTML stilovi (sluka 3.3.1). U donjem desnom uglu se
nalazi dugme New Style Cijim pritiskom otvarate prozor za definisani HTML stil. Izmene
koje napravite u okviru ovog prozora uti€u na tekst koji je bio izabran u trenutku kada ste
ga otvorili. Vazno je pomenuti da postoji moguénost izbora da li da se stil primeni na
selekciju ili na celi pasus. Ako ste izabrali pasus (Paragraf) uz ime novog stila pojavljuje se
ikonica u vidu obrnutog slova p. Kasnije selektovanjem bilo kog dela teksta i pritiskom na
prethodno napravljeni zeljeni stil, primenjujete taj stil na tekst.
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Define HTML Style

RENTERN hamed]

Apply To: () Selection (]
() Paragraph 11)

jI:SS iy whhen Appliing: () Add to Existing Style [+
yles i A
%[HTML ?tul.etg Shll (%) Clear Existing Style
g’ Clear Selection Style Fant &ttributes:
j’r Clear Paragraph Style : . ]
1 nowi Font: |Werdana, Arial, Helvetic  +
New Style Delete Style > Size: |4 2
'\.\ Calar: EEHDDESES ;
- eV, Swle: | B| T
[Wlet | apph 1 1 '

Paragraph Attributes:;
Farmat: | Paragraph % b

Alignment: = g

[ ] l [Eancel] [ Help ] [ Clear ]

Slika 3.3.1 HTML Stil

Za formatiranje koje azurira izgled celih strana koriste se kaskadni opisi stilova, CSS
stilovi (Cascading Style Sheets). Za rad sa CSS stilovima koristi se kartica CSS Styles
odmah do kartice HTML Styles u panelu Design. Da bi definisali novi CSS stil kliknite
dugme New CSS Style u donjem desnom uglu ove kartice (slika 3.3.2). U prozoru New
CSS Style oznacite Make Custom Style, polje Define in ostavite po default-u i kliknite OK.
Zatim imenujte novi stil i saCuvajte ga u folderu sajta u kome bi trebalo da se nadu i slike
koje kristi va$ sajt. Sad se pojavljuje prozor CSS Style definition na €ijoj levoj strani mozZete
videti 8 kategorija (slika 3.3.2).

U kategoriji Type moguce je podesiti parametre vezane za font, kao $to su tip, veli€ina,
boja...fonta. U kategoriji Background izabirate boju pozadine, sliku pozadine... Razmak
izmedu reci, poravnanje teksta, uvlacenje od margina, itd.

Kada ste podesili parametre shodno vasim potrebama, kliknite OK i postupak definisanja
novog CSS Styla je zavrSen. Da bi primenili stil na Web stranu treba samo da ga oznacite
u CSS panelu i ‘taknete’ dugme Attach Style Sheet (slika 3.3.2). Ako kasnije Zelite da
promenite odredene parametre CSS stila tu je i dugme Edit Style Sheet.
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CS5 Style Definition for .unnamed? in novi.css

Categony Type
b - v
B
leadcr Size: W | o Weight: w
Lizt
Pasilioring Sihyer d Watiank: W
E utensions %
v Desian = Line Height: ¥ Case: W
| 55 Styles | HTML Stles | Behaviors | Decorsbors [ underine coor: ]|
(3 Apply Styles (%) Edit Stylez [ overine
Untitled-1 . L] inethecuugh
e Edit Style [ i
nowi.css Hew CSS [Irone
Attach ' Style
Style
‘\\\ [ ok || cencel || pph || Heo |
=f +] 2

Slika 3.3.2 CSS Stil

3.4 Specijani znakovi, horizontalne linije, datum

Prilikom rada u Dreamweaveru vrlo Eesto zatrebaju znakovi i ostale informacije kojima ne
moZete pristupiti direktno sa tastature. Ovi specijalni znakovi imaju specificne HTML
kodove ili alternativne precice sa tastature koje je teSko zapamtiti.

U Insert Panelu na kartici Charactes se nalaze najceSc¢e koris¢eni znakovi (slika 3.4.1). Da
bi ubacili odredeni znak oznacite mesto na strani, a zatim pritisnite znak i on ¢e se pojaviti
na tom mestu.

t [EDmmDnTLagDut [TextTTahlesTFramesTFu:urmsTTemplatesTCharactersTMediaTHeadTScriptT.ﬁ.pplicatinn]
Bk« »-|f€¥loam™E
Slika 3.4.1 Specijalni znakovi

Ako znak koji vam treba nije na ovoj kartici, pritisnite dugme Other Character (poslednja
ikonica desno) ili izaberite opciju menija Insert>Special Characters>Other. Kada se otvori
okvir Insert Other Character izaberite znak koji zelite i kliknite OK.

Horizontalna linija se pruza preko cele strane i vizuelno odvaja delove dokumenta. Da bi
ubacili horizontalnu liniju na Zeljeno mesto na kartici Common sa Insert panela pritisnite
dugme Horizontal Rule (slika 3.4.2). Dok je oznadena horizontalna linija, u panelu
Properties (slika 3.4.3) mozete odrediti koliki deo strane ¢e odvojiti horizontalna linija, bez
obzira na Sirinu prozora browsera (u %). Ako Zelite da linija ne menja Sirinu kada korisnik
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promeni veli€inu prozora browsera, zadajte Apsolutnu Sirinu linije (u pikselima). Da bi ta
linija bila puna treba iz pola Shading ukloniti znak potvrde. Debljina linije se bira unosom
broja u polje H (height) (slika 3.4.3).

Horizontalna linija

o [CummunTLagoutl Text. TabIEETFramesTFn:\rms}fTemmEharactersTMediarHead Script] F'.pplicatin:rn[
YOS EHERD @ E S @I@E‘

Dodavanje datuma
Slika 3.4.2

Horizontal Fule W :EIZI_ 1] = m Align Diefault |

H [10 Shading

Slika 3.4.3

Automatsko dodavanje datuma. To nije dinamicki datum koji se menja kada korisnik
pristupi strani, nego datum koji pokazuje kada ste posledniji put azurirali sadrzaj strane.
Dreamweaver automtski azurira izmene svaki put kada snjimite dokument. Datum se
obi¢no stavlja na dno strane. Pritisnite dugme Date na kartici Common u panelu Insert
(Slika 3.4.2). Tada se otvara prozor Insert Date i pruza mogucénost izbora rasporeda dana,
datuma i vremena.
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Poglavlje 4

Rad sa grafikom

U ovom poglavilju naucicete:

1. Da postavite drzac slike i sliku na Web stranu

2. Promenite velicinu slike i da je pozicionirate na strani

3. Date imena grafickim elementima i pridruzite im HTML
oznake <alt>

4. Koristite panel Assets i napravite Flash dugme

4.1 Postavljanje slike na stranu

Najrasprostranjeniji formati slika na Web-u jesu format za razmenu grafickih elemenata
(Graphic Interchange Format, GIF), i format zdruzene grupe fotografskih stru¢njaka (Joint
Photographic Experts Group, JPEG). Po pravilu GIF se koristi kda slika ima velike
jednobojne povrsine bez teksture i malo ili nimalo prelivanja boja. Gif je dobar pri radu sa
tekstom, vektorskom grafikom, slikama sa ograni¢enim brojem boja i slikama malih
dimenzija. Slike u ovom formatu se mogu snjimiti sa maksimalno 256 boja (8 bita za opis
boje svake tacke). Ove slike se brze ucitavaju, i podrzavaju providnost i animaciju.

JPEG se koristi za fotografije i druge slike s velikim opsegom boja. Odli¢no reprodukuje
prelive boja i daje fotografije mnogo boljeg kvaliteta od onih u formatu GIF. Ovaj format
opisuje svaku tacku slike s 24 bita, Cuva sve njene boje.

Da bi postavili sliku na stranu, pritisnite dugme Image na kartici Common Insert panela.
Prikazace se prozor Select Image Source (slika 4.1.1). Do tog prozora mozete doéi i
biranjem opcije Image iz menija Insert. Sada je potrebno (ako to ve¢ nije slucaj) kod pitanja
'Select File Name From' oznaciti opciju 'File system'. Dugme Data Sources koristi se za
dinamicke prezentacije u kojima se dokument izvrSava na serveru aplikacije. Sada
pronadite Zeljenu sliku. Kada ste to uradili, potrebno je zadati kako ¢e Dreamweaver
referencirati grafiCki element (sliku), u odnosu na stranu, ili na osnovni (korenski)
direktorijum sajta. U referencama u odnosu na dokument Dreamweaver gradi putanju slike
na osnovu relativnog poloZzaja HTML dokumenta u odnosu na graficku datoteku. Kod
referenci u odnosu na korenski direktorijum sajta, putanja slike gradi se na osnovu
relativnog polozaja HTML dokumenta u onosu na osnovni direktorijum lokacije. Po pravilu
treba koristiti referencve u odnosu na stranu. Obrnuto samo u slucaju velikog sajta ili kada
nameravate da ¢esto menjate strane.

Vazno je napomenuti da Dreamweaver ne moze da naprvi ovakve reference ako
prethodno niste snimili stranu, ve¢ pravi putanje na osnovu polozaja slike na hard disku,
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Sto nisu valjane hiperveze i ne rade kada se sajt postavi na Web. Takode je obavezno
snimiti sliku negde unutar osnovnog korenskog foldera.
Pritisnite dugme OK i slika je na strani.

Ako trenutno nemate potrebnu sliku, mozete da rezerviSete mesto za nju. Tako Cete
otprilike moc¢i da procenite kako ¢e izgledati kombinacija slike, teksta, tabela i drugih
elemenata strane. Pritisnite dugme Image Placeholder na kartici Common panela Insert.
Otvori¢e se okvir za dijalog Image Placeholder (slika 4.1.2). U polje name upiSite ime slike,
to je tekst koji se pojavljuje samo u Dreamweaveru. Ako browser ne moze da prikaZe sliku,
ili je posetilac iskljuio moguc¢nost prikazivanja slika, na mestu gde treba da dode slika
prikazuje mu se alternativni tekst koji upisujete u polje Alternate Text. Zadajte Zeljenu
visinu i Sirinu u pikselima (standardna Sirina i visina rezervisanog mesta iznosi 32x32).

Select Image Source E]

Select File Mame From: (&) File system
{7 Data Sources

Laok ir: |_} Lszets ' v O b A Image Preview

Dirnensions: 208 x 150
Type: ACDSes JPEG Image
Size: 13,1 KB

File name: [ |
Flesof ype: [Image Fies (g po*peapra) v
URL: (fle: 4/ Diacuments and Settings/Tiki/zekihs |

Relative To: | Document v | Unlitled-1

Document should be saved to uze thiz option, Preview Images

Slika 4.1.1 lzbor slike

Kada napravite potrebnu sliku treba da je stavite na mesto rezervisano za nju. Dva puta
kliknite rezervisano mesto u prozoru dokumenta. Otvori¢e se prozor Select Image Source
prethodno objasnjen. Izaberite sliku, kliknite OK i slika e ispuniti mesto rezervisano za nju.
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Image Placeholder @

Marmne: sllkal | k. |
width: |32 Height: | 32

Albernate Text: | ovdje stoji slika

Slika 4.1.2 Definisanje drzaca slike

4.2 Menjanje veli€ine slike i njeno pozicioniranje

Kada postavite sliku na stranu njena S$irina i visina pokazuju se na panelu Properties (slika
4.2.1), i automatski upisuju u HTML kod. Veli¢ina slike bitno uti¢e na brzinu njenog
uCitavanja. U Dreamweaveru moZete da promenite te dimenzije jednostavnim unosom
8irine i visine u panelu Properties. Kada jednom promenite veliinu slike brojevi koji
oznacavaju njene dimenzije su podebljani. Takavim nainom promene veli€ine ne menjate
veli¢inu graficke datoteke. JoS jedan nacin promene veliCine slike je povlacenjem
takozvanih rucica oko slike. Ako hoc¢ete da odnos Sirine i visine ostane nepromenjen drzite
taster Shift dok povlacite ru€ice. Vracanje slike na originalnu veli€inu se vrsi pritiskom na
dugme Reset Size. Kvalitet slike opada kada se slika poveéava. Slike se u browserima
prikazuju u rezoluciji ekrana, koja uobi€ajeno iznosi 72. tacke po in¢u. Ova rezolucija nije
dovoljna za lepo prikazivanje uvecéanih slika. Da bi smanijili veliinu grafi¢kih datoteka na
najmanju mogucéu meru obavezno ih najpre prilagodite u programima za obradu slika, kao
Sto je na primer Adobe Photoshop. Editivanje selektovanih slika vrsi se pritiskom na
dugme Edit panela Properties. Odredivanje editora slike moguce je u kategoriji File types,
opcije Preferences iz menija Edit (ctrl + U).

Kada smestite sliku neposredno u stranu, nemate mnogo mogucnosti da je premestate. Tu
su standardne opcije za poravnanje, uz levu marginu, desnu ili na centar strane koje se
nalaze u panelu properties.

Ponekad treba istaknuti sliku u odnosu na pozadinu. Jedan od nacina da se to postigne
jeste i dodavanje okvira oko slike. Okvir moze da privu¢e paznju na slike i da doprinese
ujednacenosti stila cele Web prezentacije, a takode moze da posluzi kao hiperveza.
Debljina okvira se proizvoljno zadaje tako $to u panelu Properties upiSete Zeljeni broj u
polje Border ( taj broj je broj piksela). Boja okvira je jednaka podrazumevanoj boji teksta
zadatoj u prozoru Page Properties. Ako slici pridruzite hipervezu (naredne lekcije), boja
okvira te slike postace jednaka podrazumevanoj boji hiperveza.

Uredenju rasporeda doprinosi i moguénost omotavanja teksta oko slike. Ako unesemo
sliku na levu stranu dokumenta tekst ¢e i¢i desno od nje na visini donje ivice slike do
desne margine, zatimse u novom redu vraca i pocinje od leve. Izbor atributa Left ili Right
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opcije Align daje mogucnost da pored slike upiSete viSe redova teksta, sa leve odnosno sa
desne strane. Dok ostale opcije sluze za smestanje samo jednog reda teksta do slike,a to
su:
- Baseline, poravnava dno slike sa osnovnom linijom teksta (Default)
- Top, poravnava sliku sa vchom najviSeg objekta u redu, gde taj objekat moze biti
tekst ili slika,
- Middle, poravnava osnovnu liniju teksta sa sredinom slike,
- Bottom, isto kao i Base line,
- Text Top, najcesce daje iste rezultate kao i opcija Top, ali ne i uvek,
- Absolute Middle, poravnava sredinu slike sa sredinom reda teksta ili sa najveéim
objektom u redu,
- Absolute Bottom, poravnava dno slike sa najnizom tackom reda teksta.

ok Image, 11K W 160 Sro I:Shn:\pnf:artwnrk_ﬂbn_:hat1.gi|‘ {a.-l_"l Al L
" H |38 Link, %1 |& _Edit | | ResetSize |
Map | W Space Target Border =
h i t::l ':{:j HSpace | | Low Sre | {}} [y Adign | Default w

Slika 4.2.1 Panel svojstava slika

Kada omotate tekst oko slike moguée je prilagoditi prostor oko nje, da bi se tekst lakSe
Citao i da bi strana izgledala urednija. MozZete dodati vertikalni i horizontalni prostor, tako
Sto Cete u panelu Properties (slika 4.2.1) upisati potreban broj u polje V ili H. (taj broj je u
pikselima). Zapamtite da ne moZete dodati prostor samo na jednu stranu slike.

4.3 Davanje imena i HTML oznaka <alt> slikama

Imena i oznake <alt> su vazne iako se uglavnom ne vide na Web strani. Po pravilu je
dobro pridruziti slici ime i oznaku jer time pomaZzete i sebi i posetiocima sajta. Polje za ime
slike na panelu properties nema posebnu oznaku a nalazi se u gornjem levom uglu,
neposredno ispod podataka o veli€ini slike. Ime koje pridruZite slici je interno i terbalo bi da
svim slikama date imena (kratka i napisana malim slivima bez razmaka i specijalnih
znakova).

Tekst iz polja alt prikazuje se umesto slike ako je posetilac onemogucio prikazivanje slika u
svom browseru, ako njegov browser uopste ne moze da prikazuje slike ili ako ucitavanje
odredene slike nije uspelo. Umesto slike tada se prikazuje tekst koji ste upisali u polje alt.
Svim grafi¢kim objektima koji su neophodni za navigaciju po lokaciji morate upisati tekst u
polje alt.
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4.4 Panel Assets i Flash dugme

Da ne bi pamtili svojstva svih slika, naroCito na velikim sajtovima pomaze vam panel
Assets (slika 4.4.1). On se nalazi u grupi panela Files pored Site panela. Na ovom panelu
moZete raditi na dva nacina, uz izabranu opciju Site, 5to daje celokupan spisak svih slika u
sajtu, ili uz izabranu opciju Favorites, kada imate spisak u koji dodajete slike po izboru.
Ako sajtu dodate novu sliku ona se nee odmah pojaviti na panelu Assets, zato je
potrebno pritisnuti dugme Refresh Site List u donjem desnom uglu panela.

Gl Da bi ubacili sliku na oznateno mesto u dokumentu,
Site | g ocatz | jednostavno je izaberite sa panela Assets i kliknite

: o aes e oite EYE v ites insert. Preporudljivo je slikama odmah zadati imena i
L0 C 2 <alt> oznake da bi ustedeli vreme i olak3ali kasniji
Bl gew e < amostan
Y N e Jos jedan naclin za uStedu vremena je smestanje
i] o onih slika sa kojima Cesto radite u spisak Favorites.
_ U ovaj spisak mozZete smestiti bilo koju sliku
‘il sadrzanu unutar osnovnog direktorijuma sajta, tako
ML : | .A Sto Cete je oznaciti u opciji Site i kliknuti dugme Add
@ | Dlmberts—?“j]pg to Favorites u donjem desnom uglu. Kada izaberete

[ Otroberts_int.jpg : graficki objekat u spisku Favorites dugme Add to
[E Otroberts_thmb.jpg Favorites se pretvara u dugme Remove from
[ | B 02holman2e_ext.jpg Favorites, pa tako moZete i ukloniti Zeljenu sliku iz

B 0zholman2e_int.jpg ovog spiska. Za organizaciju slika panela Favorites

[y Ozholman2e_thmb.... koristi mogu¢nost dodavanja foldera u spisak

By 03snowgoose_ext,... ! Favorites (dugme New favorites Folder).

[B 03snowgoose_int.jpg

B 03snowgoose_thm...

[By 04bwister_ext.jpg

B otwseitpy g

£ >

(Linsen | CLF+

Slika 4.4.1 Panel Assets

Dodavanjem Flash objekata mozZete da postignete specijalne efekte. Flash dugmad ima
nekoliko stanja u zavisnosti od polozaja pointera misa. Prvo stanje je izgled dugmeta kada
pointer nije na njemu. Drugo stanje je kada pokaziva¢ jeste na dugmetu ali taster miSa nije
pritisnut. Treée stanje je kada je pokaziva¢ na dugmetu a taster pritisnut. Da bi napravili
Flash dugme u panelu insert izaberite karticu Media i pritisnite ikonicu Flash dugmeta
(slika 4.4.2). Otvori¢e se prozor Insert Flash Button (slika 4.4.3).

| Comman T Layout | Teut | Tables r Frames T Forms T Templates r Characters r Media r Head r Script T Application ]

.Eﬁmum

Slika 4.4.2 Kartica Media i Flash dugme

-|
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lnsert Flash Bulton |?< ]

s ——
Button Text
Sty [P T S ~
Beveled Rect Bronze
| Boveled Rct-Green
i
 Elip Axrew
Bl Warper ™
Button Texk: | Home
Font: |Verdana v ses [12 |
Target: | e
Bgcoler: [f[ |
Save As: | button?. s |

Slika 4.4.3 Izbor Flash dugmeta

U spisku Style izaberite stil dugmeta, u listi Font font a u polju Size odgovarajuéu veli€inu.
Naravno sve ove parametre i kasnije mozZete promeniti. Ovde mozZete odrediti i boju
pozadine dugmeta (polje BG color). Tekst dugmeta upisujete u polje Button Text, a ime
pod kojim ¢e te ga zapamititi u Save As. Da bi videli efekte novog dugmeta pritisnite dugme
Play na panelu Properties. Tada se dugme 'ponasa' bas onako kao u browseru. Za prekid
probe tu je dugme Stop.
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Poglavlje 5

Dizajniranje Web strana

U ovom poglavlju ¢ete naucditi:

1. Da kreirate tabele u Layout i Standard prikazu
2. Menjate svojstva i elemente tabele
3. Pravite okvire za tabele i ugnjezdene tabele

5.1 Kreiranje tabela u Layout i Standard prikazu

Jednostavne Web strane se brzo prave smesStanjem teksta i slika neposredno na stranu.
Medutim, tabele pruzaju viSse mogucnosti za razmeStanje elemenata na strani. One
omogucavaju predstavljanje informacija na organizovan nacin, jer sadrze redove i kolone
¢elija u koje se smesta sadrzaj. Vise Celija se moze objediniti u velike éelije.

Prikaz Layout je sliCan programu za pravljenje rasporeda elemenata na strani, gde se
crtaju pravougaonici u koje zatim ubacujete tekst i slike. Veli¢inu i raspored tih
pravougaonika moguce je proizvoljno menjati.

Da bi dosli u prikaz Layout na panelu Insert izaberite karticu Layout i pritisnite opciju
Layout View (Slika 5.1.1). Prikazace vam se obavestenje pod naslovom 'Getting Started in
Layout View', koje ukratko opisuje osnovne alatle ovog prikaza.

| Commoanaguut rText Tab|ESTFraI‘nESTFDrI‘I‘|SI TemplatesrCharacters|TMediaTHeadrScriptT.ﬁ.pplication]
Alatka Za Al
I s atka za
Standard View i ﬁ i ii .
Layout view crtanje celija p crtanje tabela
Slika 5.1.1 Layout View

.Jm..?
B

Alatka Draw Layout Cell sluzi za crtanje celija tj. Pravougaonika bilo gde na strani. Sadrzaj
tabele je podeljen na njene cCelije, jer sve tabele imaju jednu ili vise éelija u preseku kolona
i redova. Kada oznacite ovu altku pokaziva¢ se dovodenjem u prozor dokumenta menja u
znak plus (+). Crtanje ¢elije je jednostavno: dovedete pokaziva¢ do Zeljenog mesta, zatim
pritisnete miSa i vu€ete ga dok kontura ¢éelije ne bude odgovarajuce veli¢ine. Automatski se
iscrtava tabela Sirine prozora dokumenta (njenu veli€inu je moguc¢e menijati), i u njoj celija
koju ste sami nacrtali (slika 5.1.2). Tabela je oznacena zelenom bojom, ¢éelija plavom, a svi
ostali delovi tabele (osim ¢elije) sivom bojom. Tanke bele linije naznaCavaju redove i
kolone koje je Dreamweaver nacrtao oko celije. Na vrhu tabele prikazuje se traka koja
olakSava prepoznavanje tabele i ona sadrZi meru Sirine kolona tabele i njihove podmenije.
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Podmeni dobijate pritiskom na strelicu — nadole, desno od broja koji prikazuje Sirinu
kolone. Celija se bira pritiskanjem njene ivice (tako da se vide njene rucice), ane
postavljanjem tastera u nju.

Tasteri sa strelicama pomeraju Celiju za po jedan piksel. Ako pri tom drzite taster Shift,
pomerace se po 10 piksela. Prilikom crtanja ¢elija pojavljuju se bele vodice koje olakSavaju
crtanje drugih celija. Ako hocéete da nacrtate viSe Celija bez stalnog pritiskanja dugmeta
Draw Layout Cell, drzite taster Ctrl. Unosom nekog objekta, npr. slike u celiju ona ¢e se
(ako je manja) automatski prilagoditi veli€ini slike. Ako je slika manja trebalo bi da sami
promenite veli€inu Celije koriS¢enjem rudica.

Postoji nekoliko karakteristika éelija koje mozZete menjati. MoZete da obojite pozadinu
svake celije zasebno ili cele tabele. Takode mozete da kontroliSete horizontalno i
vertikalno poravnanje objekata unutar svake celije. Sadrzaj ¢elije se u HTML-u standardno
horizontalno poravnava sa levom ivicom celije, a vertikalno sa sredinom ¢elije.

L.ag:::lJt Table Lagnut Wi
ik Tk 17T = | 26 * ¢ 155 +— 4 v —

Celija

/ Oznacena

_ - celija
Rucica celije
Tabela !

Slika 5.1.2 Layout prikaz; tabela i ¢elije

U prikazu Layout mozete da kontroliSete Sirinu tabele na dva nacina, koris¢enjem
podrazumevane Sirine (Fixed) ili opcije Autostrech koja prouzrokuje da ¢elije automatski
menjaju Sirinu u zavisnosti od Sirine prozora browsera. Izbor ovih opcija se vrsi u panelu
Properties. UkljuCivanje automatskog odrzavanja Sirine kolone mogucée je i u podmeniju u
zaglavlju kolone izborom opcije Make Column Autostrech. Ukoliko slika za odrzavanje
razmaka nije pridruzena sajtu pojavice se prozor Choose Spacer Image, gde mozete
izabrati ve¢ postojecu sliku za razmak ili kreirati novu. Ako odluCite da ne koristite slike za
odrZzavanje razmaka, kolone menjaju veli€inu, pa ¢ak i nestaju, ukoliko nemaju sadrzaj.

Koristeéi standardni prikaz prilikom izrade tabela moracete sami sve da uradite, ali ovom
prikazu ne nedostaju prednosti. Naime, ovde su preciznost i kontrola izrade tabele dosta
povecani. Standardni prikaz izabirate na kartici Layout panela Insert (slika 5.1.1). Prva
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ikonica sa leve strane sluzi za unos tabele (Insert Table). Za unos tabele moze posluZiti i
dugme Table na kartici Tables panela Insert. Otvori¢e se prozor Insert Table (slika 5.1.3).

Insert Table @
Riows: | 2 Cell Padding: | 2
Columns: | 2 Cell Spacing: | 2 Cancel
Width: | 500 Fixels v Hedp
Border: |0

Slika 5.1.3 Unos tabele

Prozor za unos tabele sadrzi slede¢e parametre:

- Rows, broj redova tabele. Podrazumevana vrednost u Dreamweaveru je 3.

- Columns, broj kolona tabele. Podrazumevana vrednost u Dreamweaveru je 3.

- Width, Sirina tabele u pikselima ili u procentima Sirine prozora browsera. Za
precizno odredivanje rasporeda objekata bolje je koristiti dimenzije u pikselima.

- Border, debljina ivice tabele. Podrazumevana dabljina je 1 piksel.

- Cell Padding, razmak izmedu sadrzaja ¢elija tabele i njenih ivica. Ako necete
razmak upiSite nulu, a ako ostavite prazno polje bi¢e izabrana podrazumevana
vrednost od jednog piksela.

- Cell Spacing, razmak izmedu c¢elija tabele, ne raunajuéi ivice. Prazno polje znaci
da je izabrana podrazumevana vrednost a to je 1 piksel. Takode mozete upisati
nulu ako necete razmak.

Kada ste napravili tabelu potrebno ju je popuniti. Za kretanje izmedu ¢&elija moZete koristiti
tastere sa strelicama ili taster Tab. Ako predete u Celiju koja ve¢ ima sadrzaj, on ¢e biti
izabran kada koristite Tab. Ako imate tekst utabeli unutar nekog drugog dokumenta npr.
Microsoftovog Worda, mozete ga lako prebaciti u Dreamweaver. Tu tekstualnu datoteku
treba snimiti u Wordu ili je exportovati u formatu 'comma delimited file (.cfs)', jer ¢e tako
Dreamweaver moci da je procita. Ovaj format mozete koristiti i npr. u Excelu. Da bi uneli
tekstualnu datoteku izaberite opciju menija <Insert Table Objects>, Import Tabular Data ili
pritisnite ikonicu Tabular Data na kartici Common panela Insert i popunite prozor Import
Tabular Data. Dobiéete tabelu prema vrednostima parametara koje ste izabrali, u koju su
uvezeni podaci iz izabrane tekstualne datoteke.

Mozete istovremeno da kopirate i prenesete viSe Celija, ne gubedi njihovo formatiranje, a
moZete i da kopirate i prenosite samo sadrzaj Celija. MoZete kopirati i preneti jednu celiju
na mestu izabrane celije, ali ne mozZete kopirati dve ¢&elije i preneti ih tako da zamene
jednu celiju. Broj i orijentacija ¢elija koje kopirate mora da odgovara broju i orijentaciji ¢elija
koje nameravate da zamenite. Kopiranje viSe Celija odjednom je moguce jedino ako one
¢ine pravougaonik. Da bi izabrali sve ¢elije tabele pritisnite ¢eliju u gornjem levom uglu i
prevucite miSem do celije u donjem desnom uglu. Izabrane ¢elije imaju crne ivice. Ovim
nacinom izabrali ste sve ¢elije tabele, ali ne i samu tabelu.

Izbor tabele se vrSi na slededi nacin: oznacite bilo koju Celiju tabele i izaberite HTML
oznaku <table> u biracu oznaka (Tag Selector) u donjem levom uglu prozora dokumenta.
Takode tabelu mozete oznaditi pritiskom na njen gornji levi ili desni ugao ili na donju ili
desnu ivicu. Kada izaberete tabelu oko nje se prikazuju rucice za promenu veli€ine.
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Osim HTML oznake <table>, u biracu oznaka prikazuju se i oznake <tr> i <td>. Oznaka
<tr> predstavlja red, a <td> podatke (Celiju tabele). 1zabrane ¢elije ili celu tabelu mozete
obrisati tasterom Backspace.

5.2 Promena svojstava i elemenata tabele

Veli€inu tabele je lako promeniti i lako joj je dodati nekoliko kolona ili redova. Da biste
prosirili tabelu dovedite pokazivaé miSa na desnu ivicu tabele i kad se on pretvori u
dvostranu strelicu povucite ivicu kolone u desno.

Da bi dodali novi red pritisnite taster Tab ako je pokaziva€ u poslednjoj celiji tabele. Kada
oznacite dve ili vise susednih ¢elija istog reda ili kolone mozete da ih pretvorite u jednu
¢eliju pritiskom na dugme Merge cells (slika 5.2.1). Na isti na€in mozete da podelite ¢eliju
na vise manjih, pomoc¢u dugmeta Split cell. Ne moZete objedinjavati celije u obliku slova
'L". Izborom opcije menija Modify > Table > Insert Rows or Columns moguée je uneti
proizvoljan broj redova ili kolona u tabelu.

Mogu se izabrati i nesusedne celije, drzanjem tastera Ctrl. Samo kopiranje i preno$enje
nesusednih ¢elija nije moguée. Promena boje pozadine pojedinih éelija , viSe Celija ili cele
tabele, u zavisnosti od opsega celija koji je izabran, je mogu¢ na panelu Properties (slika
5.2.1). Isto tako i dodavanije ili promena pozadinske slike.

Podrazumevano horizontalno poravnjanje je Left (poravnata je leva ivica sadrzaja Celije) a

podrazumevano vertikalno pravnanje je Middle (sadrzaj ¢elije poravnava se po visini sa
sredinom svake celije).

Poravnanje po Poravnanje Bez prelamanja Pozadinska
horizontali \ / po vertikali / teksta slika

/

Format | None w | /3| Detpult Font v S :Nnne- v |_1|r BOEF = ===

Link | ) w 3 Target B s e
= :;l Cell  Horz| Default W\ Mowrap[7] Bg |5
| ijiw" | H \Header Eg I___ Erdr |_)

Split Sirina\ _ _

Merge = (delenje) ~ Visina \ . Boa  Boa
(objedinjavan;j glavy pozadine ivice ¢elije
e Celija)

Slika 5.2.1. Karakteristike Celije tabele

Inae u donjoj polovini panoa Properties nalaze se polja za zadavanje sledecih
karakteristika ¢elije:

- Merge, objedinjuje dve ili vise ¢éelija u jednu,

- Split, deli ¢eliju na viSe ¢elija
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- Horz, sadrzaj celije poravnava po horizontali (opcija default — za obi¢ne celije
poravnanje u levo, a za cCelije prvog reda centriranje)

- Vert, sadrzaj ¢elije poravnava po vertikali (default — poravnanje po sredini)

- Wi H, zadaje visinu i Sirinu izabranih Celija u pikselima. Ako hocete da zadate
dimenzije u procentima upisite znak procenta posle numeri¢ke vrednosti.

- No Wrap, spreCava prelamanje teksta ¢elije; Sirina &elije se prilagodava koli€ini
teksta koji u nju upiSete. Obo¢no se éelije proSiruju horizontalno, tako da stane
najduza re€, a zatim vertikalno kako dodajete tekst.

- Header, formatira svaku celiju kao da je u zaglavlju tabele (bold i centrirano),

- BG (gornje), zadaje pozadinsku sliku izabranog opsega ¢elija,

- BG (donje), zadaje boju pozadine izabranog opsega celija,

- Brdr, zadaje boju ivice celije.

Sortiranje tabele se postize sortiranjem sadrzaje njenih kolona. Ne mogu se sortirati
tabele koje nemaju jednak broj ¢elija u svakoj koloni. Oznadite tabelu koju zelite da
sortirate. 1z menija Commands izaberite Sort Table. Da bi sortirali tabelu morate da zadate
sledete parametre:
- Sort By, izaberite kolone koje treba sortirati,
- Order, zadajte abecedno ili numeri¢ko sortiranje i izaberite rastuci (Ascending) ili
opadajuci (Descending).
- Then By, ovo polje sluZi za zadavanje sekundarnog sortiranja po nekoj drugoj
koloni,
- Sort Includes First Row, daje mogucnost sortiranja i prvog reda (ako nije
zaglavlje),
- Keep TR attributes with sorted Row, ova opcija omoguéava zadrzavanje
odgovarajucih atributa (boja, pozadinska slika...) odredenog reda tabele i na svom
novom mestu u tabeli.

U prikazu standard mozete da pravite i tabele sa slikama. Tabele se Cesto koriste za
rasporedivanje viSe slika na strani ili za sklapanje slike koja je bila iseCena na delove. Slika
se deli na vise manjih delova da bi se optimizovale za Web (smanjuje se veliina datoteke
uz zadrzavanje najveéeg moguceg kvaliteta slike). Kada u Dreamweaveru umetnete slike
u Celije tabele, prazne ¢elije se toliko smanje da izgleda kao da ih nema. U tom slucaju
koristite tastere sa strelicama za dolazak do tih éelija. Kada dovedete pokazivaC u
skupljenu ¢eliju ona ¢e poceti da se Siri ¢im upiSete malo teksta u nju. Vazno je da
uklonite suviSne znakove i tekst iz tabela u koje ubacujete sliku, jer oni mogu uzrokovati
razne probleme narocito ako je veli¢ina tabele proraunata tacno za odredene slike.

5.3. Ugnjezdavanje tabela i pravljenje okvira

Ugnjezdena tabela je smeStena u celiju druge tabele. Ugnjrzdavanje tabela omoguéava
izradu sloZenijih strana, iako je svaka od tih tabela pojedinatno veoma jednostavna.
Preporucljivo je praviti tabelu koju treba da ugnjezdite izvan tabele u koju je ugnjeZzdavate,
jer joj se tako jasno vide ivice dok umecete potrebne slike i ostalu sadrzinu. Takode treba
voditi raCuna o tome da isprekidane linije u Dreamweaveru zauzimaju po jedan piksel
Sirine i da samim tim tabela izgleda vece nego $to jeste, jer se ti dodatni pikseli ne vide u
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browserima. Sam postupak ugnjezdavanja se obavlja funkcijama Copy i Paste, menija Edit
(mozete koristiti i Cut ako Zelite da istovremeno kopirate i uklonite malu tabelu).

Nemoijte koristiti ugnjezdavanje tabela dublje od Cetri-pet nivoa, jer jednostavniji raspored
strane znadi i da ¢e HTML kod biti jednostavniji, pa ¢e se strana brze ucitavati i lakSe Cete
otkriti i otkloniti greSke u kodu.

Tabelu moZete uokviriti zadavanjem debljine okvira (ivice) u polju Border na panelu
Properties. Medutim, tako dobijeni okviri se nejednako prikazuju u razli€itim browserima,
stoga je preporudljivo koristiti ugnjeZzdene tabele za pravljenje okvira. Dakle, treba napraviti
tabelu (recimo sa jednim redom i jednom kolonom) kod koje ¢e udaljenost sadrzaja od
ivica ¢elija biti minimum jedan i u nju uneti novu tabelu Sirine 100% (tako se i upiSe). Ova
tehnika omogucéava bolju kontrolu izgleda okvira tabele. Ako zadate veéu udaljenost
sadrzaja ¢elija od njihovih ivica (Cell Padding) kod spoljne tabele, dobicete deblji okvir
tabele.
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Poglavlje 6

Hiperveze (linkovi)

U ovom poglavlju naucicete:

1. Da napravite tekstualne i graficke hiperveze i hiperveze za
slanje elektronske poste

2. Upotrebite sidra za prelazenje na razlicite delove strane

3. Napravite mapirane slike koje imaju po nekoliko hiperveza

6.1 Pravljenje tekstualnih i grafi€kih hiperveza

Mo¢ HTML-a potiCe od njegove ugradene mogucnosti da poveze tekstualna i graficka
podru¢ja sa drugim dokumentima. Browser obi¢no istiCe ta podrucja (bojom ili
podvlaéenjem) kako bi ukazao korisniku da su to hipertekstualne veze. Hiperveza u
HTML-u ima dva dela: ime (ili URL adresu) datoteke s kojom se povezuje i tekst ili grafiku
koja sluzi kao podruc¢je koje se moze kliknuti i naziva se aktivno podrucje (hotspot) na
strani. Kada posetilac klikne na aktivno podrucje, browser koristi putanju hiperveze za skok
do povezanog dokumenta.

Da bi zadali boje pojedinih vrsta hiperveza izaberite opciju menija Modify Page Properties
(slika 6.1.1):
- Hiperveze (links), poCetna boja koju korisnik vidi pre nego $to pritisne hipervezu.
Podrazumevana boja u browserima je plava.
- Posecene hiperveze (visited links), boja u koju hiperveza prede kada je korisnik
pritisne. Standardna u browseru je ljubicasta,
- Aktivne hiperveze (active links), boja u koju hiperveza prede kada je korisnik
pritisne i zadrzi taster miSa pritisnut. Podrazumevana boja je crvena.
Pritisnite OK kada ste odredili boje hiperveza i saCuvaijte stranu.

Text [ Visited Links: [ | #990066
Lirik.s: !J HOODOCC | Active Links:LﬁFFEIEII_:IEI [

Slika 6.1.1 Definisanje boja hiperveza

Kako je vec¢ reeno, hiperveze vode posetioca do drugih dokumenata unutar tekuc¢e Web
strane ili do strana na drugim lokacijama. Postoje dva opS$ta pristupa kreiranja hiperveza
(linkova): napraviti set praznih strana, zatim ih povezati, i na kraju stavljti sadrzaj u njih; ili
kreirati link na stranu koja jo$ ne postoji, pa je tek kasnije formirati i dati joj ime koje ste ve¢
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naveli pri kreiranju linka. Napraviti hipertekstualnu vezu je veoma jednostavno (slika 6.1.2).
Treba oznaditi odreden deo teksta (1), na panou Properties pritisnuti drugu ikonicu desno
od polja link (2). Otvorice se prozor Select File u kome treba izabrati stranu sa kojom
zelimo da napravimo vezu (3). Pritisnite OK (4) i ime te strane pojavi¢e se u polju Link, a
tekst koji ste izabrali bice oznaCen kao hiperveza (5) i imace boju koju ste mu odredili u
Page Properties-u.

1 (=) Design ] Trdex 3

Druga strana == i =
2 |Zimm lﬂ prva
@ buttonl
' @ buttonz

|j custumerSerwce

Flruga)

& aF. 4 %

File name: él:.l.ruga

Files of type: .-'1‘-.IIF|IES [x.x.].

Druga strana == ) -
5 URL: | druga. htm

Relative To: | Dacument V: pria

Slika 6.1.2 Pravljenje hipertekstualne veze
Postoji jo$ jedan, jednostavniji, nacin za kreiranje linka (slika 6.1.3). Kao i pre oznacite
zeljeni tekst (1), a zatim na panelu Properties pritisnite prvu ikonicu (2) do polja Link (Point

to File), zadrzati taster miSa pritisnut i prevuéi pokaziva¢ do Site Panela (3). Pustite taster
taCno iznad strane sa kojom Zelite da napravite link (4). | link je napravljen (5).

i 1 Site | Aszets |

Druga strana ==
File- Edit- “iew. Site.

@0|@1§5"‘%|D

GI:::I::aI rental cz % | |Local Yiew Y [

= Ei Site - Global rental car (E: 'I,DIIIELIITIE
l__‘ LD Design

@
o
il ce.htm
-l druga.htm
Druga strana == d Indez.htm 4
=gl nowa.htm
5 “oidl prva,hem

[# &ﬁ' Desktop

Slika 6.1.3 Drugi nacin kreiranja linka
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Ako znate imena strana sa kojima se povezujete, mozete ih upisati neposredno u polje
link. Ukoliko iste hiperveze koristite viSe puta, usStedeéete vreme ako u padajucoj listi
desno od polja linka (pano Properties) izaberete neku od nedavno koris¢enih hiperveza.
Kada ste napravili hipervezu(e) obavezno je proverite (da li vodi do Zeljene strane) u
vasem browseru (F12).

Ovako napravljen link je primer relativne putanje (u prozoru Select File, izaberite
Document za opciju Relative Tool) Sto je najbolja varijanta za lokalne hiperveze na vecini
sajtova. Relativha putanja izostavlja deo apsolutne URL adrese koji je isti za tekuéu stranu
i za stranu povezanu sa njom, a ostavlja onaj deo koji se razlikuje. Link do strane u istom
direktorijumu, npr. bio bi druga.htm.

Za povezivanje sa stranama unutar sajta, kao i sa drugim Web lokacijama, mozete da
upotrebite i slike. Postupak kreiranja grafiCke hiperveze je isti kao i postupak kreiranja
tekstualne veze. Jedina razlika je u tome $to sada biramo odredenu sliku a ne tekst. Da bi
napravili link koji ¢e biti apsolutna putanja (koji ¢e sadrzati celokupnu URL adresu
povezanog dokumenta), potrebno je selektovati neku sliku ili tekst i u polju Link na panelu
Properties upisati celokupnu URL adresu, npr. http://www.fon.bg.ac.yu/ . Kada u browseru
pokazivatem predete iznad slike, on se pretvara u Saku koja pokazuje da je slika
povezana hipervezom. Ako slika ima okvir, boja okvira ¢e biti jednaka podrazumevanoj boji
hiperveze, koju ste zadali u panelu Page Properties-u.

Kada posetilac pomocu linka ode na odredenu Web stranu, ona obi¢no zameni tekucu
stranu njegovog browsera. Medutim, ponekad je pogodnije da se nova strana prikaze u
drugom prozoru, jer ako ste, npr. link usmerili prema dokumentu van vase lokacije,
posetioca Cete izvesti van vasih strana. Pa ukoliko on nije zapamtio URL adresu vaseg
sajta, mozda neée znati da se vrati na nju. Ako se spoljna hiperveza otvori u novom
prozoru browsera, originalna strana ostaje prikazana na prvom prozoru. U Dreamweaveru
se mesto prikazivanja strane na koju dospevate pritiskom na hiprvezu, zadaje
usmeravanjem ka cilju (target), a to se vrsi u polju Target, odmah ispod polja Link na
panelu Properties. Osim opcije _blank, ostali ciljevi se korise uz okvire (frames) o kojima
¢e biti govora kasnije. Ciljevi mogu biti:
- _blank, ucitava povezanu stranu u nov prozor,
- _parent, uCitava povezanu stranu u roditeljski skup okvira, ili prozor onog okvira
koji sadrzi hipervezu,
- _self, uCitava povezanu stranu u isti okvir ili prozor koji sadrzi hipervezu (ovo je
podrazumevani cilj),
- _top, uCitava povezanu stranu i njime ispunjava prozor browsera, ¢ime uklanja sve
okvire sa ekrana.

Pravljenje hiperveza za slanje elektronske poste je veoma znadajno, jer na taj nacin
olakSavate posetiocima da se poveZu sa vama. Oznaclite mesto na strani gde Zelite da
umetnete hipervezu za slanje Emaila. Na panelu Insert, kartici Common pritisnite dugme
za hipervezu sa slanje poruka (Email Link). Pojavice se prozor Email Link (slika 6.1.4), gde
unosite tekst (koji ¢e se prikazati na strani kao hiper veza) i Email adresu. Ako prethodno
izaberete tekst koji se vec nalazi na strani i zatim otvorite prozor Email Link izabrani tekst
¢e se pojaviti u polju tekst.
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Email Link @

- - ]
Text: | korkakt . k

:
-'

Slika 6.1.4 Prozor za formiranje Email linka

S pmer@yLbe net

U polje Link na panou Properties upi8ite mailto: i zatim bez razmaka Email adresu (slika
6.1.5). Tako ste 'ruéno’ napravil vezu sa slanje Email poste.

Farmat | Paragraph | 2 | Default Font w| Size i
Link. :mailtn:primer@eunet.gu w @"a:l

Slika 6.1.5 Unos linka za Email

6.2 Umetanje sidara i povezivanje sa njima

Kada je dokument dugacak ili ima mnogo odeljaka, obi¢no se pravi niz hiperveza koje
odvode posetioca na odredeno mesto u dokumentu. Sidro (named anchor) oznacava
mesto na strani na koje dovodi hiperveza.

Na slici 6.2.1 je ukratko prikazan nacin kreiranja sidra i veze sa njim. Postavite kursor na
neki deo strane (gde Zelite da umetnete sidro, obiCno pri kraju strane). Pritisnite dugme
Named Anchor (1) na kartici Common na panelu Insert. Otvara se prozor gde treba da
unesete ime sidra (2). Ime sidra ne sme da sadrzi razmake, znakove interpunkcije i
specijalne znake. Svako sidro na strani mora imati jedinstveno ime, inae browser nec¢e
znati na koje od istoimenih sidara da ode. Na strani, sidro je predstavljeno Zutom ikonicom
(3) koja se inace ne vidi u browseru. Jo$ jedan nacin za unos sidra je opcija Insert >
Named Anchor.

Sada na strani (obi¢no na vrhu) izaberite tekst (4) koji ¢e odvesti posetioca na
odgovarajuci odeljak strane (do odgovarajuc¢eg sidra). Da bi pretvorili taj tekst u hipervezu
koja referencira sidro u panelu Properties, u polje Link upiSite #imesidra (7) i kliknite
Enter. Znak # govori browseru da je ovaj link unutradnji, tj. da se zadrZzava na originalnoj
strani. Ime koje ste upisali posle znaka # mora biti identi¢no imenu sidra.

Ako sidro umetnete na pogreSno mesto, mozete ga premestiti prevlacenjem.

Drugi nadin za izradu linka sa sidrom je da oznadite Zeljeni tekst (4), kliknete ikonicu Point
to File (5) (prva ikonica do polja Link u panelu Properties) i prevucete ikonicu (6) do sidra
koje ste prethodno napravili (1,2,3) (pustite taster miSa tac¢no iznad sidra). Ovaj nacin je
sigurniji jer koris¢enje ikonice Point to File smanjuje verovatno¢u da ¢ete pogredno otkucati
ime sidra.
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A 1
%-ﬁmm

Anchor Mame; 2

|imesida]
v |
r.'Li nelki tekst____l 3 Link | #imesidra

Slika 6.2.1 Kreiranje sidra i veze sa njim

Na dugackim stranama uobiCajeno je da se na kraj svakog odeljka stavi link do sidra na
vrhu strane ili do navigacionog sadrzaja. Ovo sidro obi¢no se zove #top. U ovom slucaju
korisnici ne moraju da premotavaju stranu do vrha kako bi dosli do linkova za prelazak na
druge odeljke.

Broj linkova na jednoj strani koji referenciraju isto sidro je neogranicen.

6.3 Mapirane slike

U ovoj lekciji nastavljamo da radimo sa sidrima. Kroz izradu mapiranih slika videcete kako
se pravi link sa odredenim odeljkom drugog dokumenta.

Sliku na strani mozete da podelite na nekoliko hiperveza pomoc¢u mapirane slike (image
map), 5to je naziv za sliku sa vi8e aktivnih podrucja. Ta aktivha podrucja mogu imati razne
oblike (pavougaona, kruzna, oblik poligona).

Izaberite sliku na strani na kojoj Zelite da napravite aktivha podruéja. U polije Map na
panelu Properties upiSite zeljeno ime ove slike (sada mape). Ono ne sme da sadrzi
razmake i specijalne znake. Svaka mapirana slika na strani mora imati drukcije ime. Ako
zaboravite da mapiranim slikama date ime, Dreamweaver ¢e to uraditi umesto vas (Map1,
Map2, Map3,...). Sada izaberite jednu od alatki za crtanje aktivnih podrucja (Slika 6.3.1).
Oko odredenog dela slike (dela koji Zelite da postane aktivno podrucje) nacrtajte aktivno
podrucje (providno plavozeleno) drzeéi pokaziva¢ misa (slika 6.3.2). Pomocu alatke za
pokazivacka aktivna podrudja (Pointer Hotspot) mozete koristeéi rucice tog podrucja fino
da ga podesite oko nekog dela slike, ili da ga pomerate (drzedi taster iznad tog podrucja).
Ako hoéete da uklonite aktivho podrudje, izaberite ga i pritisnite Backspace.
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o,) Hotspot Link [drugsstrana htmisidrot oD
=i e 2 T
Target | W |
Map [delploce

N T\::i

Alatka za paligonalna aktivna podrudja
Alatka za ovalna aktivha podruéja
Alatka za pravougaona aktivna podrudja
Alatka za pokazivacka aktivna podrudja
Slika 6.3.1 Alatke za mapirane slike

Slika 6.3.2 Mapirana slika

Da bi napravili link za aktivno podruje, treba ga oznaciti i u polje Link na panelu
Properties upisati adresu strane ili Web sajta na koju Zelimo da dovedemo posetioca kada
klikne na deo slike sa tim aktivnim podrucjem (prethodno treba obrisati znak # koga
Dreamweaver automatski upisuje u polje link kada napravite aktivno podrucje). Da bi, npr.
napravili link do sidra na drugoj strani naSeg sajta treba upisati npr:
imedrugestrane.htm#imesidra (ako je druga strana u istom direktorijumu kao i ona u kojoj
pravimo mapiranu sliku; a ako je u drugom direktorijumu bilo  bi
imedirektorijuma/drugastrana#timesidra). Sidra koja omogucéavaju povezivanje sa razli€itim
delovima drugih strana, povecéavaju funkcionalnost sajta, odmah usmeravaju posetioce na
ono &to traZe i skracuju vreme potrebno za premotavanje velikih strana.

Ako mapiranu sliku kopirate na drugu stranu , Dreamweaver ¢e u kopiji zadrzati sve
linkove i aktivna podrucja.
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Poglavlje 7

Izrada interaktivnih strana

U ovom poglavlju cete nauditi:

1. Da napravite sliku s prelazom (Rollover Image)
2. Da otvorite nov prozor browsera
3. Napravite iskacuci meni

7.1 Rollover Image

U ovoj lekciji upotrebicete posebne skriptove, koji se u Dreamweaveru zovu 'ponasanja’,
(behaviors), za pravljenje slika sa prelazima, novih prozora browsera i iskacucih menija.
Skript kombinuje odredeni dogadaj koji je izazvao korisnik (npr. dovodenje pokazivaca
misa iznad nekog dugmeta u cCitacu) sa jednom ili viSe akcija koje su posledica tog
dogadaja. U pozadini 'ponasanja’ lezi gotov JavaScript kod.

JavaScript se na Web stranama Cesto koristi za pravljenje slika sa prelazom —slika koje se
menjaju kada posetilac dovede pokaziva¢ miSa iznad njih. U Dreamweaveru mozete
napraviti ovakve slike a da pritom ne bacite nijedan pogled u HTML i JavaScript kod.

Da bi napravili sliku s prelazom na izabranom mestu na strani pritisnite dugme Rollover

Image na traci Common panela Insert. Otvorice se prozor Insert Rollover Image (slika
7.1.1).

Insert Rollover Image @

Image Mame: | THEEEH
Canel |
Original Image!
' _Heltl
Rollover Image: Browse. ..
Preload Roflover Image
Alternate Text:
Wihen Clicked, Go To URL:

Slika 7.1.1 Prozor za formiranje slike sa prelazom
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Pozeljno je da date ime slici (ako to ne uradite Dreamweaver automatski dodaje svoja
imena npr. Image1, Image2, ...). Ta imena moraju biti smislena i ukazivati na namenu
slika. U imenima ne sme biti razmaka i specijalnih znaka. Prvo treba da unesete sliku koja
¢e biti original, tj. Sliku koja ¢e biti na strani pre nego $to posetilac dovede pokaziva¢ misa
iznad nje (dugme Browse do polja Original Image). Zatim treba da unesete sliku koja ¢e se
pojaviti kada posetilac prede pokazivatem preko originalne slike (dugme Browse do polja
Rollover Image). Slika sa prelazom koja se pojavljuje na pocetku i ona koja je zamenjuje
treba da imaju iste dimenzije, ine e druga slika biti smanjena ili uve¢ana u skladu s
dimenzijama prve slike i zato izobli¢ena. Takode odmah moZete napraviti graficku
hipervezu unoseci u polje 'When Click, Go To URL' URL adresu ili putanju do povezane
strane. Ako ne upiSete nista u ovo polje, Dreamweaver upisati znak #, u polje link na
panelu Properties. Taj znak saopStava browseru da pokaziva¢ miSa pretvori u Saku kada
ga korisnik dovede iznad slike, ali i da ga ostavi na toj strani kada klikne na nju. Ovdje
mozete zameniti ovaj znak proizvoljnom hipervezom ka drugoj strani istog sajta ili bilo
kakvom URL adresom, ali ne smete ovo polje ostaviti prazno jer Cete tako ukloniti
JavaScript kod koiji izvrSava prelaz sa jedne slike na drugu.

Ova metoda je dobra ako prethodno niste uneli sliku, jer omoguc¢ava da istovremeno
unesete sliku i da je definiSete kao sliku s prelazom. Naravno moguce je i slici koja je veé
na strani dodati prelaze i to pomocu panela Behaviors iz grupe panela Design. Sliku kojoj
zelite dodati prelaz oznalite, na panou Behaviors pritisnite dugme sa znakom (+) i
izaberite opciju Swap Image (engl. swap — zamena).

= Desi NPT Shes T Sl Ir,hauim =
! HTML Stglesﬁm ﬂ;] <imgs Actions ﬂj
ﬂj pr Actions il‘ﬂ : E-.u;-nts . Actions . |

; [onfausetiut) Swap Image Festore
Events Actions [onMaousever) Swap Image
1 lzbor

- dugadj aja
Set Mav Bar Image Dogadijaj Akcija
Set Text v :
Show Pop-Up Menu Images! |image "plocal” /-
: = L3 | image: "original” *

R T ]

Swap Image Restore .
Timeline P

[ 1§ ]

Set Source fo: :.Desig_nll'gﬁ.ssets!l'ima_g_ ZE_ll'l'_|:E_|'|a._]'E|_l:;|-_ ]

Slika 7.1.2 Formiranje prelaza za postojecu sliku

Pojavice se prozor Swap Image gde u spisku Images treba izabrati sliku koja ¢e biti
zamenjena (original). Ako slikama niste dali imena one se ovde navode kao 'unnamed
<img>'. Zato je vazno slikama dati odgovaraju¢a imena (kako Cete izmedu bezimenih slika
izabrati onu koja vam treba?). Sada pritiskom na dugme Browse do polja Set Source to:
izaberite sliku koja ¢e zameniti originalnu. UobiCajeno je (radi lakSeg snalaZenja) imenu
pocetne (originalne slike) dodati sufiks _off, a imenu slike koja zamenjuje originalnu sufiks
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_on. Nakon izbora slike za zamenu, u spisku Images do imena originalne slike (slike kojoj
je pridruzen skript, odnosno prelazak na drugu sliku) stoji zvezdica. Opcije Preload Image i
Restore Image onMouseOut obavezno potvrdite. Opcijom Preload Image izbegavate
kasnjenje koje bi uzrokovalo ucitavanje zamenske slike tek kada posetilac prede preko
pocetne slike, a opcijom Restore Image onMouseOut obezbedujete da se zamenska slika
zameni pocetnom kada kada posetilac pomeri pokaziva€ miSa izvan nje. Pritisnite ok i
formirali ste prelaz za postojecu sliku, 8to se vidi i u panelu Behaviors kada oznacite sliku
(vidite spisak akcija - Actions koje izvrSava Dreamweaver, u zavisnosti od odredenog
dogadaja — Events u browseru posetioca).

MoZete da zamenite viSe slika istovremeno kao posledicu istog dogadaja. Npr. kada
posetilac dovede pokaziva¢ mida iznad jedne slike, dve slike mogu da budu zamenjene,
odnosno da predu iz svojih poCetnih stanja u zamenska stanja. Za to je potrebno da
napravite jednu Rollover sliku. Zatim da na panelu Behaviors dva puta kliknete na akciju
Swap Image. Otvori¢e se prozor Swap Image, dakle isti onaj koji smo koristili za izradu te
Rollover slike. Sada u spisku Images izaberite tu drugu sliku strane koja ¢e se zameniti
svojom zamenom. Kada odredite zamensku sliku za tu drugu sliku (u polju Set Source to:)
pritisnite OK i 'isprobajte’ stranu u browseru. Kada predete pokazivatem misa preko prve
slike, i ona, i druga slika se menjaju svojim zamenskim slikama koje ste zadali. Imajte u
vidu da mnogo ovakvih efekata prelaza moze prili€éno da uspori rad korisnikovog browsera.
Ponekad je potrebno da se prelazak odigra samo kada postilac klikne na odredeni deo
slike. To bi to napravili prvo mapirajte sliku (napravite na njoj jedno ili viSe aktivnih
prostora), oznacite aktivni prostor koji treba da izazove zamenu mapirane slike (dakle,
samo klikom na taj deo slike vr§i se njena zamena), pritisnite dugme (+) na panelu
Behaviors i u podmeniju izaberite akciju Swap Image....(dalji postupak je identi¢an izradi
obi¢ne Rollover slike).

Akcije i dogadeaje mozete da menjate na nekoliko nacina. Mozete da promenite dogadaj
na akciji koja odgovara, da pridruzite viSe akcija istom dogadaju i da menjate redosled
izvrSavanja tih akcija. Na primer, Swap Image je akcija, a onMouseOver dogadaj koji
odgovaraju skriptu za sliku sa prelazom. Da bi dodali akciju poruke koja iskace izaberite
sliku na strani pritisnite (+) na panelu Behaviors i u padajuéem meniju akcija izaberite
akciju Popup Message. Otvorice se prozor u koji treba da upiSete poruku. Pritisnite OK i
na panelu Behaviors ¢ete videti da je akcija (skript) Popup Message pridruzena
odgovaraju¢em dogadaju. Da bi promenili taj dogadaj oznacite ga i pritisnite strelicu
nadole desno od njega. Pojavljuje se lista moguéih dogadaja (slika 7.1.3).

Na dnu ove liste nalazi se opcija Show Events For u kome birate tip ¢itata za prikazivanje
dogadaja. U zavisnosti od akcije i Citaca koje ste izabrali menjaju se i dogadaji u meniju. U
zagradama se prikazuju dogadaji za koje je potrebno sidro smeSteno oko objekta. Ako
pravite sliku sa prelazom Dreamweaver ¢e automatski napraviti potrebno sidro tako sto ¢e
uneti znak # u polje Link panela Properties, a ako ne, morate sami da unesete ovaj znak ili
aktivnu hipervezu u ovo polje.

Browser izvrSava akcije po njihovom redosledu u spisku. Taj redosled moZete promeniti
pomodu strelica gore-dole u gornjem desnom uglu panela Behaviors.

Nemojte dodavati previSe poruka ni slika koje iskacu, jer one brzo dosade posetiocu.

Da bi zeljenu akciju-dogadaj izbrisli, oznacite ih i pritisnite znak (-) koji se nalazi odmah do
znaka (+).
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Events Actions

bl Popup Meszage
[enfiouseCiur]
[onfouzeluer] onAbart
onError

onLoad

[onClick)
[onDblClick)
[onkeyDowm)
(onkeyPress)

fonkeyUp)
fonMousebowmwn)

[onMousetk) k
[onMouseCver)
[onMouselp)

Show Events For  #

Slika 7.1.3 Izbor dogadaja

Poruka na statusnoj traci je poruka koja se pojavljuje na statusnoj traci u dnu browsera,
zamenjuje podrazumevano prikazivanje URL adrese ili putanje do povezane strane, i daje
posetiocu kratak opis sadrzine na koju vodi hiperveza (pomaze mu pri kretanju po sajtu).
Da bi je uneli, izaberite sliku na strani, pritisnite dugme (+) na panelu Behaviors i izaberite
akciju Set Text > Set Text of Status Bar. Otvara se prozor u koji unosite poruku. Pritisnite
OK i sada mozete izabrati dogadaj koji ¢e pokrenuti tu akciju (ispis poruke na statusnoj
traci). Obi¢no je to (onMouseQver).

7.2 Otvaranje novog prozora browsera

Ova lekcija pokazuje kako se otvara nov prozor browsera kada se strana ucita, sto se
koristi za reklame i mnostvo drugih informacija. Ranije je reCeno da nov prozor otvara i
standardna hiperveza kojoj zadate cilj _blank, ali tako ne mozZete da kontroliSete atribute
tog prozora. Nasuprot toj opciji skript Open Browser Window omoguc¢ava kontrolisanje
veli¢ine i mnogih drugih atributa novog prozora, kao $to su trake za pomeranje i trake s
menijima.

Oznacite deo teksta od koga zelite da napravite link ka strani koja ¢e se otvoriti u novom
prozoru. Zatim u polje Link panela Properties unesite znak #. Ovaj znak omoguc¢ava da mu
dodelite skript Open Browser Window. Pritisnite znak (+) na panelu Behaviors i izaberite
akciju Open Browser Window. Otvori¢e se istoimeni prozor (slika 7.2.1).

Pritiskom na dugme izabirate stranu koja ¢e se ucitati u nov prozor (ili unesite URL adresu
strane). U poljima Window Width i Window Height unosite Sirinu i visinu prozora,
respektivno. Ako prikazujete reklamu zadajte veliinu novog prozora prema Sirini i visini
reklamne slike. Sledeci atributi koje mozete zadati su:
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7.3

Navigation Toolbar, red dugmadi za navigaciju, medu kojima su Back, Forward,
Home i Reload,

Open Browser Window

URL to Display: | druga, him | | Browvese. .. h{
Window Width: | 300 | window Height: | 150
dttributes: [] Mavigation Tookar — [[] Menu Bar

[] Location Toolbar Scrolbars as Needed

] statusBar [] resize Handles
Window Name: '

Slika 7.2.1 Definisanje novog prozora browsera

Location Toolbar, red opcija medu kojima je i polje za adresu,

Status Bar, podrucje na dnu prozora browsera u kome se prikazuju poruke (URL
adresa, preostalo vreme za ucitavanje,...),

Menu Bar, podrucje prozora browsera u kome se prikazuju meniji File, Edit, View,
Go i Help. Ako zelite da posetioci mogu da krstare iz ovog prozora potvrdite ovo
polje, u protivnom ¢e oni samo moci da ga minimiziraju ili zatvore,

Scrollbars as Needed, prikazuje trake za pomeranje ako je sadrzina strane veca
od vidljive povrSine novog prozora. Ako je isklju¢ena i slede¢a opcija, Resize
Handles (prikazivanje ru€ica za promenu veli€ine prozora), posetioci uopste nece
modi da vide ostatak sadrZine koji nije stao u prvobitnu veliinu novig prozora. U
tom slucaju zadajte veli€inu novog prozora tako da odgovara celokupnoj sadrZini
strane.

Resize Handles, daje moguénost posetiocu da promeni veliinu prozora, bilo
povlagenjem rucica, bilo pritiskom na dugme Maximize,

Window Name, ime novog prozora, ako hocete da usmeravate linkove na ovaj
prozor ili da ga kontroliSete JavaScript kodom.

Iskacuci (Pop-Up) meni

Skriptove za iskacu¢e menije mozete da ukljucite medu ostale elemente za kretanje po
prezentaciji, kako biste posetiocima pruzili spisak moguénosti iz kog ¢e birati.

Iskacu¢i meni mozemo pridruziti slikama ili aktivnim podruéjima mapiranih slika. Recimo da
Zelimo da ga pridruzimo odredenom aktivnom podruc¢ju mapirane slike. Za to je potrebno
da oznacite taj aktivni deo, pritisnete znak (+) na panelu Behaviors i u meniju akcija
izaberite skript Show Pop-Up Menu. Pokazace se istimeni prozor sa aktivnom karticom
Contents (slika 7.3.1). Tu zadajete opcije koje ¢e sadrzati vas meni, tako $to u polju Text
upisujete ime opcije (podrazumevani tekst New Item briSete), a u polju Link, hipervezu za
tu opciju. Pritiskom na dugme (+) u polju Menu iznad polja Text, dodajete nove opcije
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vasem meniju (naravno, ponovo im morate dati ime i link). Za promenu redosleda opcija
oznacite opciju i pritiskajte dugmad gore-dole.

Show Pop-Up Menu

| Conkents i ;ﬁ.ppearance Advanced Position |
Dodavanje _Drisanje  Podmeni Hipsibasbiodd
Menu; +_;— HIE' 4|~
Text: |ime opcije’ i Target: |opciied ¥
Link: illnlz | 3
Texk | Link. fTarget
ime oprijel firk, za
ime oprijez firk, oprijez
ime opcijes opcijes

Slika 7.3.1 Prikaz Pop-Up menija

Ako hocete da uklonite opciju iz menija izaberite je i pritisnite dugme (-). Mozete da pravite
i podmenije, izborom opcije koja treba da postane podmeni prethodne opcije u meniju i
pritiskom na dugme sa sliCicom smaknutog srednjeg pravougaonika. Ako hocete da
premestite opciju u podmeni viSeg nivoa, pritisnite dugme sa sliCicom poravnatih
pravougaonika.

Na kartici Appearance (slika 7.3.2) izabirate orijentaciju menija horizontalno-vertikalno,
font, veli€¢inu slova, poravnanje teksta. Takode moZzete odrediti boju ¢éelije i teksta kada
pokaziva¢ miSa nije na njoj i obrnuto.

Conkents ].ﬁ.ppearance! Advanced | Position

I'-.-'ertiu:al Menu v |

Fank: | Cefaulk Fonk

#Size L] B 7| E E

LIRSS

L

p State: Ower Skate:

Texk: ﬂ Texk: D
Cell: E Cell: ﬂ

Slika 7.3.2 Definisanje izgleda Pop-up menija

Na kartici Advanced, birate Sirinu i visinu ¢elije (najéeS¢a opcija je Automatic), udaljenost
sadrzaja celije od ivica menija (Cell Padding), razmak celija (Cell Spacing), uvlacenje
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teksta od ivice menija (Text Indent), vreme potrebno za zatvaranje menija kada posetilac
pomeri pokaziva¢ van njega (Menu Delay), pojavljivanje okvira i njegovu debljinu (Border
width), boju okvira i boju senke opcije (Shadow).

Na kartici Position birate poziciju menija u odnosu na objekat koji ga aktivira. Moguce
varijante su prikazane na slici 7.3.2. Obavezno oznacite opciju Hide Menu on onMouseOut
(da bi meni nestao kada pomerite pokazivaC miSa sa njega). U poljima X i Y se nalaze
udaljenosti menija od objekta koje su unapred date u zavisnosti od izabrane pozicije, a
mozZete ih i promeniti.

Menu Position: B D. | ﬁ | D.:.I

wi[4s0 | v:|z00] |

Hide Menu on onMouseOut Event

Slika 7.3.2 Mogu¢i polozaj menija
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Poglavlje 8

Rad sa bibliotekom

U ovom poglavlju c¢ete nauditi:

1. Da napravite elemente biblioteke i da ih postavite na stranu
2. Promenite elemente biblioteke
3. Napravite i promenite elemente biblioteke koji sadrze skriptove

8.1 Pravljenje i postavljanje elemenata biblioteke

Ima mnogo elemenata i grupa elemenata koji se ponavljaju na viSe strana sajta (elementi
za kretanje po sajtu, informacije o autorskim pravima, =zaglavlja, podnozja...).
Dreamweaver omoguc¢ava da se ovi, Cesto koriS¢eni elementi snime u biblioteku
elemenata. Biblioteka elemenata omoguéava da izmenite pojedine elemente i da potom
jednom naredbom azurirate sve strane koje sadrze taj element. Da ne postoje biblioteke
elemenata morali biste ru¢no da menjate elemente i njihove parametre na svim stranama
pojedinacno.

Element biblioteke pravite tako Sto izaberete jedan ili vise elemenata strane (sve ono Sto
se nalazi izmedu oznaka <BODY> i </BODY>) i ukljuCite ga u biblioteku. Takav element,
dakle, postaje sadrZina biblioteke i sada ga ne mozZete menjati na strani. Element koji je
sadrzan u CSS stilu zadrzava parametre koje je dobio od tog stila, ali kada ga unesete na
stranu kojoj niste dodelili stil, on se na njoj prikazuje bez parametara stila.

Da bi napravili element biblioteke od viSse elemenata strane, ono moraju da d¢ine
kontinualno podrucje strane. Nesusedne elemente strane morate da pretvorite u vise
elemenata biblioteke.

Element biblioteke koji sadrzi relativne putanje (kao $to su linkovi ka drugim stranama ili
slikama) moze biti unet na bilo koji nivo u strukturi direktorijuma sajta (ako je element unet
u stranu direktorijuma u kome nije strana sa koje je formiran ovaj element, Dreamweaver
automatski utvrduje ispravnu putanju).

Da bi dosli do biblioteke na panelu Assets grupe panela Files pritisnite ikonicu Library
(slika 8.1.1). Da bi dodali izabrane objekte sa strane u biblioteku (napravili od njih
elemenat biblioteke) jednostavno ih prevucite u donju polovinu panela Library. Jo$ dva
nacina za pravljenje novog elementa biblioteke su dugme New Library ltem na dnu panela
Assets i izbor opcije menija Modify > Library > Add Object to Library. Pojavi¢e se nova
ikonica Untitled u donjem delu panelu Library, a u gornjem novi element biblioteke

- 46 -



Macromedia - Dreamweaver MX

napravljen od elemenata koje ste izabrali na strani. Sada imenujte taj novi element,
promenom imena Untitled i pritiskom na Enter. Ova imena sluze samo vama i ne vide se u
prozoru browsera. Kada od nekog objekta napravite element biblioteke on dobija
bledozutu pozadinu, $to oznacava i da se ne moze menjati neposredno na strani. Sada se
ovaj objekat smatra celinom pa ¢e se pritiskanjem bilo kog njegovog dela izabrati ceo
element biblioteke.

Kada napravite element biblioteke Dreamweaver pravi direktorijum Library na najvisem
nivou lokalnog korenskog direktorijuma i u njega smesta sve elemente biblioteke sa
nastavkom .Ibi.Taj direktorijum sa elementima biblioteke ne treba slati na server, on nam
sluzi samo lokalno, za laksi razvoj i odrZzavanje sajta.

- : OsveZavanje
M! sajta
) B3 Library
Ikonica o
biblioteke H e Pravijenje
(Library) B Customer Servi novog
® elementa
£ »
gy
i Marme | Size|Full Path /| Promena
@ Maslov 1KE jLibrary Masloy. b elementa
£ biblioteke
Unos — L
elemenata Brisanje
biblioteke elementa
[Cinzdn_| + [&F

Slika 8.1.1 Panel Library

Za unos elementa biblioteke na stranu potrebno je oznaditi Zeljeno mesto unosa i iz panela
Library prevuci Zeljeni element na to mesto, ili pritisnuti dugme Insert u donjem levom uglu
panela. Unosom elementa biblioteke na stranu, unosite sadrzinu njegove datoteke i
njegovu referencu. Za odrzavanje elementa biblioteke, izabranog na strani, upotrebite
karakteristike elemenata biblioteke prikazane na panelu Properties (slika 8.1.2)

Library Item Sre Librarghaslow |bi [ Open ] [Detach from Driginal]
Fecreats

Slika 8.1.2 Karakteristike elemenata biblioteke

- Src, prikazuje ime i lokaciju izvorne datoteke izabranog elementa,
- Open, sluzi za otvaranje datoteku elementa biblioteke radi izmena, da biste
sacuvali izmene snimite datoteku,
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- Detach from Original, raskida vezu izmedu izabranog elementa i njegove izvorne
datoteke. Sadrzina elementa moze se , nakon raskida veze, menjati neposredno
na strani, ali se ne moze azurirati funkcijama biblioteke,

- Recreate, sluzi za ponovno pravljenje elemenata biblioteke, koji su obrisani,
promenijeni ili im je promenjeno ime.

Da bi uneli element na stranu i u isto vreme raskinuli vezu sa izvornom datotekom u
biblioteci, drzite taster Ctrl dok prevlacite element biblioteke iz panela library na stranu.
Ako element biblioteke sluajno obriSete u panely Library, a jo§ imate stranu s tim
elementom, moZete ponovo da ga snimite u biblioteku tako Sto éete ga izabrati i pritisnuti
dugme Recreate na panelu Properties. Kada pritisnete element biblioteke na strani desnim
tasterom, otvorice se kontekstni meni koji sadrzi opciju Recreate i sve druge opcije koje se
odnose na izabrani element.

8.2 Menjanje elemenata biblioteke

Sve izmene elemenata biblioteke moraju se obaviti na panelu Library (slika 8.1.1). Ako
hocete da menjate element biblioteke neposredno na strani morate raskinuti njegovu vezu
sa datotekom u biblioteci (Detach from Original). Otvaranje datoteke elementa biblioteke
radi menjanja moguce je na tri nacina: dva puta kliknite na ikonicu elementa u panelu
library, ili je samo oznacite i pritisnite dugme Edit sa dna panela, ili izaberite ugradeni
element biblioteke na strani i pritisnite dugme Open na panelu Properties (slika 8.1.1).
Dreamweaver tada otvara novu stranu koja sadrzi samo taj element, ali koji sada nema
onu bledozutu pozadinu i koga mozete neposredno promeniti. Kada zavrsite sa izmenama
i saCuvate ih otvara se prozor Update Library Items (slika 8.2.1) kojim vas program pita da
li Zelite da aZurirate sve strane koje sadrzZe taj element (jer je on za sada promenjen samo
u biblioteci).

Update Library ltems

Update libramy items in these files?
fetraned Aztranal hitm : L
doustomerService. ktm Don't Update
fzamapom. htm

Slika 8.2.1 AZuriranje elemenata biblioteke na svim stranama

Kada poritisnete Update pojavljuje se prozor Update Pages koji pokazuje koje su sve
strane bile azurirane (slika 8.2.2).
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l!;') LIpdate Pages E|§|

Look in: .

(EEEEEER v | Mazloy Diane
Update: [+] Library [tems
-

Show Log  [Done

Statuz:

updated stranelstranal.htm
itern LibrarysM azlow. 1bi
Done.
filez examined: 4
files updated: 3
filez which could not be updated: 1
katal tirne: [0:00:07]

< $

Slika 8.2.2 Prozor Update Pages

Ako ste izabrali da odlozite aZuriranje strana u vreme kada ste zavrSili menjanje elemenata
biblioteke, Dreamweaver omoguc¢ava da to kasnije uradite jednom naredbom. |zaberite
opciju menija Modify > Library > Update Pages. Otvara se prozor Update Pages slika
8.2.2, na kojem mozete da izaberete opciju Entire Site u polju Look in, a sa desne strane
ime vaseg sajta i pritisnite dugme Start.

8.3 Pravljenje i menjanje elemenata biblioteke koji
sadrze skriptove

Posto se elementi biblioteke na strani moraju nalaziti unutar oznaka <BODY> i ne smeju
sadrzati (referencirati) objekte izvan tih oznaka, JavaScript se ne moze koristiti u
elementima biblioteke ukoliko skript zahteva kod strane izmedu oznaka <HEAD> i
</HEAD>, jer te oznake dolaze pre oznake <BODY>. Medutim postoji vazan izuzetak.
Skript je gotov element ¢ije JavaScript funkcije Dreamweaver umece unutar oznaka
<HEAD>, pa u elementima biblioteke mozete koristiti Dreamweaverove skriptove, premda
zahtevaju kod koji treba umetnuti u dokument unutar oznaka <HEAD> i </HEAD>. Element
biblioteke ne sadrzi kod koji treba da se nalazi unutar oznaka <HEAD> i </HEAD>, ali,
Dreamweaver automatski umece potreban kod unutar tih oznaka, kad god u dokument
ubacite odgovarajuci element biblioteke.

Dakle, potrebno je samo da oznacite Zeljeni element sa strane koji sadrzi skript (Rollover
sliku, iskacuci meni...), da pritisnete ikonicu New Library Item na dnu panela Library, i da
upiSete ime novog elementa biblioteke koga ste upravo napravili. Na kraju pritisnite Enter.

- 49 -



Macromedia - Dreamweaver MX

Ovaj element biblioteke sadrzi odredene delove koda potrebne za skript, a to su dogadaiji i
akcija koju treba pozvati kada do tog dogadaja dode. On ne sadrzi JavaScript funkcije koje
se moraju ubaciti izmedu oznaka <HEAD> i </HEAD>. Rekli smo da Dreamweaver te
funkcije automatski dodaje strani kada u nju unesete taj element biblioteke (jer prepoznaje
odredene delove koda u elementima biblioteke kao skriptove - akcije i dogadaiji).

Elementi biblioteke koji sadrze skriptove teZze se menjaju od onih koji ih ne sadrze. Ako
hocete da menjate sam skript elementa biblioteke prethodno morate da raskinete vezu
izmedu biblioteke i primerka njenog elementa na strani (dugme Detach From Original).
Kada ste promenili skript elementa sa strane, iz biblioteke obriSite originalan element (ali
prethodno zapamtite njegovo ime), zatim oznacite promenjeni element na strani i ponovo
od njega napravite novi element sa istim imenom. Sve ovo je zbog toga $to skriptove nije
moguée menjati neposredno u elementu biblioteke, pa morate da uklonite originalni
element i da ga zamenite ispravljenom verzijom. Sada mozete i azurirati sve strane sa
ovim promenjenim elementom, izborom opcije Modify > Library > Update Pages.
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Poglavlje 9

Izrada okvira

U ovom poglavlju ¢ete nauciti:

1. Da napravite i snimite skup okvira i ugnjezdene okvire
2. Da promenite karakteristike okvira i skupa okvira
3. Napravite dokument unutar okvira i traku za navigaciju

9.1 Skup okvira

Okviri dele prozor browsera na pravougaone oblasti koje se nezavisno pounjavaju HTML
sadrzinom. Okviri obi¢no dele stranu na oblast za navigaciju po Web sajtu i oblast
sadrzine. Oblast za navigaciju se najceS¢e ne menja, a oblast sadrzine menja, i to svaki
put kad se pritisne hiperveza u oblasti za navigaciju. Za prikazivanje Web strane sa dva
okvira browser koristi tri datoteke: jednu koja defini8e skup okvira i dve sa sadrZinom
svakog okvira.

Skup okvira je HTML datoteka nevidljiva korisniku koja definiSe strukturu Web strane sa
okvirima. Skup Cuva podatke o veli€ini i polozaju svakog okvira i imena datoteke sa
njihovom sadrzinom. Svaki okvir je posebna HTML datoteka. Okviri imaju ivice Cije se
prikazivanje moze iskljuciti, tako da ih korisnik ne vidi, ili uklju€iti da bi prozor bio jasno
izdeljen na okna. Okviri mogu imati trake za pomeranje sadrzaja i posetiocu moze biti
dozvoljeno da im menja veli€inu povladenjem ivica.

Postoje dva nacina da se napravi skup okvira u Dreamweaveru, moZete ih unositi ruéno, ili
izabrati neki od gotovih skupa okvira. Ovaj drugi nacin je brZi jer se tada i skup okvira i svi
njegovi okviri automatski definiSu.Kada izaberete opciju View > Visual Aids > Frame
Borders pojavice se debela ivica oko strane u prozoru dokumenta. Ako hocete ruéno da
unesete okvire, odvucite ivicu koja opkoljava stranu u prozor dokumenta. Strana ¢e se
podeliti horizontalno (ako odvucete gornju ili donju ivicu) ili vertikalno (ako odvucete desnu
ili levu ivicu). Automatski unos okvira je kao §to smo rekli jednostavniji; dovoljno je da
pritisnete npr. ikonicu Top Frame na kartici Frames panela Insert (slika 9.1.1).

Left frame Top Frame
(okvir na levoj (okvir na vrhu
strani) strane)

Kartica
Frames

I:E | Enr%n T Layout m Tables T Frames‘]fnrrni T Templates T Characters T MMedia T@' Script T .ﬁ.pplicatinn]
IFE0O0EDESBE DR« » =&

Slika 9.1.1 Kartica Frames
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Strana je sada podeljena na dva okvira, kratki na vrhu i duzi ispod njega, na dnu. Podelu
obelezava tanka siva linija. Da bi, na primer, u donji okvir dodali joS jedan skup okvira
(Ugnjezden), postavite kursor u donji okvir i pritisnite ikonicu Left Frame na kartici Frames.
Donji okvir ¢e sada biti podeljen na dva okvira: uski okvir levo i Siri desno. Umesto ovog
nacina izrade ugnjezdenih skupova okvira, Dremweaver ih ve¢ ima ponudene, takode na
kartici Frames. Strana ¢e sada izgledati kao na slici 9.1.2:

b & AN S | Tte: [Unitied Dooument @ | O < L E

Lt ke e a1 *

LI S e TETidT = EdlFee

Slika 9.1.2 Izgled strane sa ugnjezdenim okvirima

Kada stavite potreban skup okvira na stranu, treba da ga snimite. Da biste videli stranu u
browseru, i skup i datoteke sadrzine svakog okvira moraju biti snimljeni. Da bi snimili skup
okvira treba da ga oznacite. To se radi pritiskom na ivicu prozora dokumenta s unutrasnje
strane, kada ivice svih okvira postaju isprekidane, i kada se na birau HTML oznaka na
dnu prozora prikazuje <frameset>. Skup okvira moze se izabrati i na panelu Frames (slika
9.1.3) koji se dobija naredbom Window > Others > Frames, tako $to ¢ete pritisnuti spoljnu
ivicu koja opkoljava sve okvire. Na ovom panelu prikazuje se pojednostavljena verzija
strukture okvira na strani.

Posto ste izabrali (oznacili) skup okvira snimite ga izborom opcije File > Save Frameset
As. Dok je skup okvira jo$ izabran mozete ga imenovati (polije Title na Document
Toolbaru). Ako skup okvira nije izabran prilikom davanja naslova strani, naslov ¢e biti
dodeljen jednoj od strana u skupu, a ne datoteci skupa okvira. Da ne biste gresili i radili na
objektu na kome ne Zelite da radite, pogledajte Cesto na panel Frames gde se jasno vidi
Sta je izabrano.
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Ivica skupa Okuviri
okvira «— |

o

Slika 9.1.3. Panel Frames — pojednostavljena struktura okvira

9.2 Karakteristike okvira i skupa okvira

Karakteristike okvira mozete kontrolisati na panelu Properties (slika 9.2.1). U zavisnosti od
toga da li ste selektovali skup okvira ili sam okvir, opcije panela se menjaju. Ako hocete da
menjate veli€ine okvira treba da izaberete odgovarajuéi skup okvira. Veli€inu okvira
moZete zadati na panelu Properties unosom odgovarajuéih dimenzija redova odnosno
kolona u polje Value, a moZete i ru¢no da vucete ivice okvira dok ne dobijete potrebnu
veli€inu okvira. Dok menjate veliinu okvira morate voditi rauna i o sledeéim opcijama
(meni Units do polja Value):

- Pixels, ovom opcijom zadajete apsolutnu veli€inu uspravnog ili polozenog okvira,
jednako upisanom broju piksela. Za okvire koji ne treba da menjaju veli€inu ovo je
najbolja opcija. Ako ostalim okvirima zadate veli€¢inu pomocu drugih jedinica mere,
njima ¢e se dodeljivati prostor tek posto okviri &ija je veli€ina zadata u pikselima
dobiju odgovarajuce vrednosti.

- Percent, ova opcija zadaje procentualni deo skupa okvira koji tekuci okvir treba da
zauzme. Uspravni i poloZeni okviri Cija je veliCina zadata u procentima, dobijaju
prostor posle okvira &ija je veli€ina zadata apsolutno, a pre okvira €ija je velilina
zadata relativno,

- Relative, ova opcija zadaje da ¢e tekuci okvir dobijati prostor relativno u odnosu
na ostale okvire i da ¢e zadrzati tekuce proporcije. Okuviri €ija je veli€ina relativna
dobijaju prostor poslednji, posle onih Cija je veliCina zadata u pikselima ili
procentima, ali zauzimaju sav preostali prostor. Ako donjem ili desnom okviru
zadate relativhu veliCinu on ¢e ispuniti preostalu visinu, odnosno Sirinu prozora

browsera.
e —|

— Frameset Borders | Yes w | Barder Caolor Q
B I Fiows: 2 ' o
Cols: 1 Eorder Width |2 Gornji

€ Value o Units

. g | FowCal i
Fow [20 Fiels v | ool |Donji

Slika 9.2.1 Svojstva skupa okvira
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Posle izbora veli¢ine okvira snimite skup okvira (Save Frameset).

Pozeljno je svakom okviru u skupu odmah zadati ime. To nije ime datoteke sadrzine koja
¢e se u okviru prikazivati, nego uokvirine povrSine u dokumentu, a vazno je kada se prave
linkovi za prikazivanje strane na toj povrSini. Pozeljno je da imena okvira odrazavaju
buduéu sadrzinu okvira (navigacija, naslov, sadrzaj...). Da bi zadali ime okviru treba ga
prvo oznaciti istovremenim pritiskom tastera Alt i klikom miSa na Zeljeni okvir. To je
moguce uraditi i samim izborom (bez tastera Alt) tog okvira na panelu Frames. Imajte u
vidu da biranje okvira nije isto 8to i postavljanje kursora u njega. Kada ste izabrali okvir (a
ne skup okvira) panel Properties sada pokazuje njegove karakteristike (slika 9.2.2). U polje
Frame Name upidite Zeljeno ime umesto podrazumevanog, i pritisnite Enter. U imenu
okvira ne sme biti razmaka, crtica, tacaka i specijalnoh znakova. Opcijom Scroll zadajete
prikazivanje traka za pomeranje , i to vertikalne i horizontalne. Parametar Auto prikazuje
trake za pomeranje kada u okviru nema dovoljno prostora za prokazivanje sadrzine strane.
Parametar Default prihvata podrazumevani parametar browsera koji je najée$ée bas Auto.
Na panelu Properties (slika 9.2.2) u polju Borders moZete izabrati, ili ne prikazivanje ivica
okvira u Browseru. Ako izaberete vrednost Default okvir ¢e preuzeti taj parametar od
roditeljskog skupa okvira (polje Borders na Panelu Properties skupa okvira — slika 9.2.1), a
ako je izabrana neka druga vrednost (Yes ili No) ona ima prioritet na isti parametar
roditeljskog skupa okvira.

Ukoliko koristite gotove skupove okvira, polja Margin Width i Margin Height ostaju prazna i
koriste se podrazumevane vrednosti ovih parametara u browseru koje se menjaju u
zavisnosti od verzije i vrste browsera. Margin Width definiSe Sirinu leve i desne margine
okvira u pikselima, a polje Margin Height visinu gornje i donje margine.

‘__r Frame Mame Sre [zadrzaihtm €3]  Borders [ Yes v
- sadrza Seroll | Default w |:| Mo Resize Eorder Calor l_T

Plargin wWidth |
Ilargin Height
Slika 9.2.2 Svojstva okvira

Kada menjate svojstva okvira ne zaboravite da ih saCuvate (Save Frameset).

9.3 Sadrzina okvira i traka za navigaciju

SadrzZina okvira je zasebna HTML datoteka. Stranu moZete da pravite odvojeno ili unutar
granica okvira. PoZeljno je upotrebljavati skup okvira za projektovanje strana, jer tako
strane nece biti preSiroke ili preuske za svoj okvir. Ako posetioci budu morali da pomeraju
sadrzinu okvira u raznim smerovima da bi sve videli, to im se ne¢e ba$s svideti.

Kada 'popunite’ okvir, tj. stranu treba da je snimite opcijom File < Save Frame. Pozeljno je
da se svakoj strani da ime (polje Title). Naslov zapravo i nije neophodan posto ¢e browser
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koristiti naslov skupa okvira u svom prozoru. Pa ipak dobro je uvek davati naslove
dokumentima, jer ¢e tako strana imati naslov i u sluaju da bude iz bilo kog razloga
otvorena u zasebnom prozoru. Naredbom Save Frame snimate samo trenutno izabranu
stranu ali ne i skup okvira. | skup okvira treba snimiti.

Traka za navigaciju je niz slika povezanih sa stranama prezentacije. Po lakoc¢i koris¢enja
trake za navigaciju su sli¢ne jednostavnim slikama sa prelazom (Rollover Image). Svaka
slika na traci moze imati do €etri stanja u zavisnosti od akcija posetioca. Prvo stanje Up
Image prikazuje se kada se strana tek ucita. Drugo stanje Over Image prikazuje se kada
posetilac prede pokazivaem preko slike. Ista stanja imaju obi¢ne slike sa prelazom. Na
traci za navigaciju mozete upotrebiti joS dva stanja. Kada posetilac pritisne sliku prikazuje
se trée stanje, Down Image. Cetvrto stanje slike Over While Down Image prikazuje se
kada posetilac prede preko slike koju je ve¢ pritisnuo.

Traka za navigaciju sluzi za prikazivanje trenutnih i prethodnih akcija posetilaca. Trecée
stanje obi¢no izgleda kao pritisnuto dugme, Sto posetiocu ukazuje nato da je pritisnuo
sliku. Po pritisnutom dugmetu posetilac zna koju stranu gleda.

Oznacite mesto na strani (u okviru za navigaciju) gde Zelite da unesete traku za navigaciju
i izaberite opciju Insert > Interactive Images > Navigation Bar. Otvara se prozor Inset
Navigation Bar (slika 9.3.1). U polje Element Name upiSite ime prve slike na traci na
navigaciju umesto imena Unnamed1. U naredna Cetiri polja se smeStaju slike za Cetiri
razlicita stanja (polje browse) dugmeta u zavisnosti od akcija posetilaca. Zatim u polju
When Clicked go to URL napravite link za to dugme do Zeljene strane. Ta strana ¢e se
otvoriti u onom okviru koji navedete u polju posle reéi In. Imate takode moguénost izbora
horizontalne ili vertikalne orijentacije dugmadi trake za navigaciju u polju Insert. Dok birate
opcije u ovom prozoru, ime elementa (dugmeta) koje se menja prikazuje se u spisku Nav
Bar Elements na vrhu prozora. Dodavanje novih odnosno brisanje nepotrebnih dugmadi se
vr§i znakovima (+) i (-). Redosled dugmadi birate strelicama gore-dole. Pritisnite OK i uneli
ste traku za navigaciju. Ako hocete kasnije da je promenite izaberite Modify < Navigation
Bar. Otvori¢e se prozor Modify Navigation Bar gotovo identi€an prozoru Insert Navigation
Bar, samo bez mogucnosti biranja vertikalnog ili horizontalnog poloZaja trake =za
navigaciju.

Hiperveze se podrazumevano usmeravaju ka okviru ili prozoru u kome se nalaze. Ako
zelimo da se link otvara u nekom drugom okviru na Panelu Properties u polju Target
izaberite Zeljeni okvir. Kad god napravite nov okvir njegovo ime se automatski dodaje
padajucoj listi Target. U ovoj listi ima i drugih opcija. Opcija _Blank uditava povezanu
stranu u nov neimenovan prozor browsera. Opcija _Parent uditava povezanu stranu u
skup okvira koji je roditelj okvira sa hipervezom. Ako okvir koji sadrzi hipervezu nije
ugnjezden, povezana strana se uCitava u ceo prozor browsera. Opcija _Self ugitava
povezanu stranu u isti okvir ili prozor koji sadrZi link. Ovo se podrazumeva, pa to obi¢no ne
morate da zadajete. Opcija _Top uditava povezanu stranu u ceo prozor browsera i time
uklanja sve okvire.
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Insert Havigation Bar |5_(|

+| = ] =]
Mav Bar Elements: [home

Help

Element Marme: | dowwnload |

Up Image: | Images/download. gif | [Brc-wse... ]

Over Image: | Images/downloadZ. gif | [Browse... |

Down Image: | Images,download3. gif | [Browse... ]

Ower \While Down Image: | Images/download4.gif | [Browse... ]

Alternate Text: | [

When Clicked, Go To URL: | download, htrn | [Browse... ] in

Options; Preload Images

[ show "Dawn Image" Initially

e
Tnserk; | Yertically Vl Use Tables

Slika 9.3.1 Definisanje trake za navigaciju
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Poglavlje 10

Koris¢enje Sablona (Templates)

U ovom poglavlju ¢ete nauciti:

1. Da napravite i koristite Template
2. Azurirate sajt pomocéu Template-a

10.1 Pravljenje Template-a

Bez obzira na to da li pravite veliku prezentaciju sa viSe odeljaka ili sa viSe strana koje
sli¢no izgledaju, ubrzacete rad ako radite sa Sablonima. Pomocu njih mozete da promenite
vide strana ili aZurirate izgled sajta za samo nekoliko minuta. Naime, Sabloni daju stane
identi¢nog izgleda, za razliku od Assets-a (biblioteke) koji omogucava da se neki elementi i
grupe elemenata ponavljaju na stranama i tako daje ve¢e mogucénosti menjanja rasporeda
elemenata na pojedinim stranama. Zato ako Zelite strane identi¢nog izgleda Koristite
Sablone.

Template definiSe izgled i raspored strana koje ¢ete pomoc¢u njega napraviti. Kada pravite
Template obiéno najpre definiSete izgled strane i snimite je kao Sablon. Takode, mozete
koristiti i postoje¢u HTML stranu i da je snimite kao Sablon.

Iz menija File izaberite Save As Template. Otvori¢e se prozor Save As Template (slika
10.1.1), u kome birate sajt u kome cete snimiti Template. Dreamweaver Sablonu
automatski daje ime u polju Save As, Sto je ustvari ime datoteke iz koje je nastao.

Save fAs Template g]

=W G lobal rental car
Existing Templates: | [no templates]

Save As | Untitled-1 .

Slika 10.1.1 Prozor za snimanje Templates-a
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Prozor zatvorite pritiskom na dugme Save. Sablon je dodat sajtu i snimljen u direktorijum
Templates (na panelu Assets) sa nastavkom .dwt. Ako takav direktorijum ne postoji
Dreamweaver ¢e ga automatski napraviti. Svi Sabloni koje budete pravili u okviru
izabranog sajta ¢e se pojaviti u ovom direktorijumu.

Takode, umesto da snimate postojeéu stranu kao Template, mozete da napravite nov,
prazan Sablon, pomocu opcije menija Window > Assets. Zatim pritisnite ikonicu Templates
na panelu Assets. Kada pritisnete dugme New Template, na dnu tog panoa, spisku
8ablona u njemu bi¢e dodat nov 8ablon bez imena. UpiSite ime dok je jo§ oznacgen (slika
10.1.2)

Site [ p o caps |

Templates
= Thiz i= a blank termplate.
‘%‘ Ta get starked, click the & Edit button, add
R content, and mark. some regions as editable
Templates q
uzing the Modify menu.
iy
Narne Size | Ful
@ |Untitled| 1KE jTe
New
Template
£ >
Apply CH[Z M

Slika 10.1.2 Pravljenje novog Sablona

Kao Sto je veC re€eno, sve oblasti Sablona su nepromenjive. Ako hocete da menjate
informacije na stranama morate definisati oblasti na strani koje se mogu menijati. Te oblasti
po pravilu sadrze tekst i moraju biti strogo definisani kao promenijivi. Takode, prilikom rada
na Sablonu mozete da menjate i oblasti koje ¢e biti promenjive i one koje to nece biti, dok
na strani napravljenoj pomocu Sablona moZete da menjate samo oblasti definisane kao
promenjive.

Da bi otvorili napravljeni Sablon, dvaput kliknite na ime tog Sablona na panelu Assets. Na
Sablonu oznacite objekat (tabela, celija tabele, drzac¢ slike, dugme...) koji zelite da bude
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promenljiv. Zatim, na panelu Insert izaberite karticu Templates i pritisnite ikonicu Editable
Region.

“ L [Cnmmnanagnut Teut TablesTFramesrFnrmsrTemmates1Eharactersl
l@w@mma

Otvorice se prozor New Editable Region (nova promenijiva oblast). U polje Name upiSite
ime promenijive oblasti Sablona i pritisnite OK. Imena oblasti ne smeju da sadrze specijalne
znakove (znakove navoda, zagrade..) i naravno svaka oblast Sablona mora imati drugacije
ime. Ako npr. izaberete Celiju tabele kao promenijivu oblast, ista ¢e biti istaknuta okvirom u
plavoj boji, na ¢ijem vrhu jezicak Hesnskslens prikazuje ime promenjive oblasti. Ukoliko se
ne vide konture i imena oblasti izaberite opciju menija View > Visual Aids > Invisible
Elements.

Vazno je napomenuti da ne mozete definisati vise ¢elija tabele kao promenijivu oblast, veé
ukoliko to zelite, podesite da cela tabela bude promenijiva. Imena svih promenjivih oblasti
prikazuju se na dnu menija Modify, opcija Templates.

Mozete unutar same celije napraviti promenjivu oblast. Sve oko te celije ¢e biti
nepromenljivo.

Sve Sto se menja mora biti u promenjivoj oblasti, ukljucujuéi i hiperveze. Ako pravite
hiperveze u datoteci $ablona, za pronalaZenje hiperveze upotrebite ikonicu direktorijuma ili
alatku Point to File koje se nalaze na panelu Properties. Hipervezu ne smete upisivati
neposredno u odgovarajuce polje na panelu Properties, jer tada hiperveze necée raditi.
Dreamweaver automatski formira putanje kada koristite jednu od ove dve metode. Na kraju
snimite datoteku.

Menjanje promenjivih oblasti Sablona mozete kasnije da onemogucite. Iz menija Modify
izaberite Templates, a zatim Remove Template Markup. Nesta¢e kontura koja oznacava
oblast kao promenjivu i sada je taj deo Sablona zakljuan i ne moze se menjati u stranama
napravljenim pomoc¢u ovog Sablona.

Takode moZete da birate da li ¢e se sadrZzina neke oblasti prikazivati na stranama
napravljenim pomocu Sablona u zavisnosti od vrednosti izraza koji se izradunava ili od
parametra koji zadajete. Na Sablonu (ne na strani napravljenoj pomoc¢u Sablona) oznadite
objekat (oblast) koji ¢e biti opciona oblast. U panelu Insert, na kartici Templates izabrati
ikonicu Optional Region. Otvori¢e se prozor New Optional Region na kojoj izaberite Basic
(slika 10.1.3)

Mew Optional Region
| Basic Advanced
K
WE=H |. ||‘|| |r|:||F'|-|:||| |r|

- Cancel
. Show by Defaulk
Help

Slika 10.1.3 Pravljenje opcione oblasti
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U polje Name unesite ime Zeljene oblasti. Ako nameravate da koristite opcionu oblast
Sablona na vecini strana sajta (koje ¢ete praviti pomoéu ovog Sablona), ostavite polje
Show by Default potvrdeno. Ako ovo polje ostavite nepotvrdeno a Zzelite da ta opciona
oblast bude vidljiva na strani napravljenoj pomoc¢u ovog Sablona, dok je ta strana otvorena
izaberite Modify > Template Properties. Pojavi¢ée se prozor Template Properties u kome
izaberete Zeljenu opcionu oblast, potvrdite polje Show Ime vase opcione oblasti i sauvate
stranu. Isto tako, ako ste na strani napravili neku opcionu oblast, pomoéu kartice
Advanced, moZete da je poveZete sa novom opcionom oblas¢u. Na istoj kartici definiSete i
izraze (Template Expressions) koji odreduju kada se oblast prikazuje.

Oblast koja se ponavlja (repeating region) jeste podrucje strane koje se ponavlja viSe
puta. Ove oblasti su naroCito pogodne za objekte koji se ponavljaju promenijiv broj puta na
stranama i za kontrolisanje izgleda tabela koje imaju veliki broj redova i kolona. Da bi
napravili oblast koja se ponavlja, oznadite je na Sablonu (npr. zadnji red tabele), zatim na
panelu Insert, na kartici Templates pritisnite Repeating Region. Otvori¢e se prozor New
Repeating Region (slika 10.1.4).

Mew Repeating Region @

ol 4

This region will appear multiple times in Cancel
documents based on this kemplate,

Help

Slika 10.1.4 Pravljenje oblasti koje se ponavljaju

UpiSite ime Zeljene oblasti i pritisnite OK. Boja za isticanje oblasti koje se ponavljaju je ista
kao i za opcione oblasti, ali je svetlija od boje promenjivih oblasti. Da biste mogli da
menjate sadrzinu oblasti koje se ponavljaju u stranama koje ¢e te napraviti pomocu
Sablona, ubacite u njih potreban broj promenljivih oblasti ( npr. oznacite jednu po jednu
¢eliju zadnjeg reda i pritisnite dugme Editable Region). Dodavanje stavki koje se
ponavljaju, na strani napravljenoj pomocu ovog Sablona) vrsi se pritiskom na dugme (+) na
jezitku Repeat Fepeat:penavianie  *|=|v|+] "5 redosled stavki odredujete strelicama gore-
dole.

Boju za isticanje oblasti moZete da menjate i prilagodite je bojama strane, izborom Edit
>Preferences > Highlighting. Pritisnite polje palete boja Zeljene oblasti i izaberite boju za
isticanje ili upiSite njen heksadecimalni kod u pripadajuce polje.

Slededi korak je pravljenje strana na osnovu originalnog Sablona. Iz menija File izaberite
New i u prozoru New Document pritisnite karticu Templates. Na ovoj kartici prikazuje
spisak definisanih sajtova i spisak svih 8ablona pridruZenih izabranom sajtu. |zaberite
Zeljeni 8ablon, ostavite polje Update Page when Template changes (aZuriraj strane kad se
izmeni Sablon) potvrdeno i pritisnite dugme Create. Tako ste napravili novu stranu na
osnovu tog 8ablona. lako nova strana prikazuje svu sadrZinu Sablona, vi je ipak saCuvaijte.
Na novoj strani vidite boju za isticanje zakljucanih oblasti (podrazumevana boja je
svetlozuta). Kada dovedete pokaziva¢ miSa iznad oblasti (ili pokuSate da je pritisnete), on
¢e se pretvoriti u precrtan krug, sto pokazuje da se te oblasti ne mogu menjati.

-60 -



Macromedia - Dreamweaver MX

Tekstove cete najéeSCe postavljati unutar promenjive oblasti. Ukoliko ubaceni tekst
izazove prekomerno Sirenje prostora za tekst, morate zatvoriti dokument i ponovo ga
otvoriti da bi se veli€ina oblasti prilagodila njenoj sadrzini.

10.2 Azuriranje sajta pomocéu Template-a

Videli ste da pomocu Sablona moZete lako da napravite viSe strana jednakih originalnom
Sablonu, a zatim da ih popunite. Medutim, do prave ustede vremena dolazi tek kada treba
da izmenite sve strane. Bez Sablona biste morali da menjate svaku stranu pojedina¢no.
Koriste¢i Sablon menjate samo datoteku originalnog $ablona i potom azurirate sve strane
napravljene pomoc¢u njega. To cete uraditi tako Sto dvaput pritisnete Zeljeni Sablon u
kategoriji Templates, na panelu Assets. Otvori¢e se originalni 8ablon. Kada napravite
Zeljene izmene saCuvajte ga i automatski ¢e se otvoriti prozor Update Template Files koji
pokazuje spisak svih strana napravljenih pomoéu ovog Sablona (slika 10.2.1). Da bi
azurirali sve ove strane pritisnite dugme Update. Ako hocCete da odloZite aZuriranje
pritisnite dugme Don't Update. Naknadno ¢ete ih azurirati biranjem opcije menija Modify >
Templates > Update Pages.

Update Template Files

Update templates uzed in these filez? |lpdate
#zasablonorn. hirn .
Mdrugastrana. bt Don't Update

ftrecastrana.htm

Slika 10.2.1 Azuriranje strana

Takode vezu strane i njenog Sablona mozete da prekinete biranjem opcije menija Modify >
Templates > Detach from Template. Stranu c&ija je veza prekinuta mozete da menjate kako
god hocete ali se ona viSe ne azurira kada se izmeni Sablon.
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Poglavlje 11

Odrzavanje Web sajta

U ovom poglavlju ¢ete naucditi:

1. Da koristite funkcije za odrzavanje Web sajta u prikazu Site
2. Napravite mapu sajta

3. Shvatite razlike izmedu lokalnih i udaljenih Web lokacija
(sajtova) i uspostavite vezu sa udaljenom lokacijom

11.1 Odrzavanje sajta u Site prikazu

Odrzavanje Web sajta je sustinski deo razvoja projekata za Web. Prikaz Site nudi mnostvo
alatki za odrzavanje koje omogucéavaju lako azuriranje i kontrolu Web lokacije. Prikaz Site
se koristi za odrZzavanje i lokalnih i udaljenih lokacija. U njemu se sajt vidi kao spisak
datoteka, ali i kao mapa koja grafi¢ki prikazuje hijerarhiju sajta. OdrZzavanje sajta obuhvata
premestanje, dodavanje i brisanje datoteka i direktorijuma i najbolje se izvodi u prikazu
Site. Ako celokupno odrzavanje sajta i rad sa njegovim datotekama obavljate iz prikaza
Site, obezbedili ste ispravnost putanja koje upucuju Dreamweaver i browser na hiperveze,
slike i ostale elemente sajta. Putanje su ispravne zato sto Dreamweaver moze da prati
vase izmene i da na osnovu toga azurira datoteke. U protivnom, ako izmenite datoteke ili
direktorijume u prozoru My Computer ili u Windows Explorer Dreamweaver ne zna za te
izmene i ne moze da odrzi ispravnost putanja.

Do prikaza Site dolazite u grupi panela Files pritiskom na karticu Site izborom Zeljenog
sajta u padajucoj listi na levoj strani i pritiskom na dugme Expand, a to je krajnja desna
alatka na paleti alatki Site (slika 11.1.1).
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"Sit.e-;.ﬁ.m : Preuzmi i
Preuzmi ———— : : | T
] Edit~ Wiew. Sitee zakljucaj
datoteke ?'E‘\\]\@ ( | datoteke
[ ) L
P8 R ERIE
op / | '_I.Ecal ’Qf Dugme za
» Sity - vhtshop (E:) prqéiriva_njei
Povezivanje — v rhwork sa2|macrlee
Iprekidanje ' Conneckions (expand)
veze Library
stock Posalji i
. otkljucaj
Osvezi — add. asp
admin_control.asp datoteke
Lokani —— | / i admin_view, asp
korenski 3_ confirm, asp Meni prikaza
direktorijum @l contact.asp
il default,asp
Meni —— | . i@ deletel.asp " Posalji
sajtova ¢ : | B datoteke

mSIika 11.1.1 Panel Site (pre proéirehja)

Prikaz Site otvara nov prozor koji sadrzi paletu alatki sa funkcijama za odrzavanje sajta
(slika 11.1.2). U daljem tekstu se podrazumeva da radimo u ovom prosirenom prikazu Site.
Pomocéu menija sajtova lako se prebacujete na bilo koji sajt, a desni meni na vrhu panoa
sluzi za prebacivanje u prikaze Local, Remote, Testing Server i Map. Okno lokalnih

sajtova (Local
Site)

=) Macromedia Dreamweaver MX

File-» Edits Wiew. Sikes

5'5 éﬁ #&, | Site: | Global rental car v aC |3 @& 39| O I
R e dke | In... [ sizel[T... [Modified |checked Ouwt By | [Local Files .| Size] Type Modfled  |cr
=2 & Site - Global rental car ... 1f224200... -
To seq the fles on your web server, you must define s remote site =69 Design Folder  1/22/200... -
' =B Assets Folder 1fzzjz00.,. -
El Readme.txt 1KB Text Dao... 122§200... -
=6 Library Folder  2/5{2003... -
@ Maslov.lbi IKB LBIFile  2/6/2003... -
=5 mm Folder 1f22f200.,. -
. = &3 stranel Falder 2/3/2003... -
Mapa sajta @ stransihtm 3B HTMLD... Z2/6{2003... -
e archetecture. htrmd BEB HTML D... Sf24/200... -
@ customerService., . KB HTML D.., 2/6f2003... -
Testiranje @ druga.htm 1KB HTML D... 2/5j2003... -
@ Frameset.htm 1EE HTML D,., 2/7{2003... -
servera @ Index.htm 7KB HTML D.., 2[2/2003... -
= mm_menu.jis 30KB JScript ... 2f5f2003... -
L= naslov.htm IKEB HTML D... 2[/6/2003... -
. J W navigaciia.htm 4KB HTML D... 2/6f2003... -
L Okno SaJtova @ nova.htm KB HTML D... 2/Si2003... -
@ prva.htm 1KB HTML D... 2/2/2003... -
Da.tOteke na Serveru_ @ sadrzaj.htm JKB HTML D... 2/6j2003... -
saJta (Remote Slte) @ samapom.htm 11KB HTML D... 2/6/2003... -
# [E Desktop

Slika 11.1.2 ProSireni prikaz Site

-63 -



Macromedia - Dreamweaver MX

Lokalne datoteke se prikazuju u desnom okviru prozora Site. One obuhvataju celokupnu
sadrzinu korenskog direktorijuma izabranog sajta. U levom okviru (sajtovi na serveru)
prozora Site prikazuje se pomoéni tekst 'To see the files on your web server, you must
define a remote site', koji objasnjava da morate da definiSete sajt na serveru da bi se u tom
okviru prikazale datoteke smeStene na vasem web serveru.

Glavne alatke prozora Site smeStene su na paletu alatki:

- tri dugmeta na levom kraju sluZe za biranje nacina prikaza sadrZine udaljenog
sajta: datoteke lokacije (Site Files), testiranje servera (Testing Server) i mapa
lokacije (Site Map). Podrazumeva se prikazivanje datoteka lokacije.

- Meni sajtova prikazuje sve definisane sajtove

- Dugme za povezivanje/prekidanje veze uspostavlja vezu sa udaljenim sajtovima.
Ako jo$ niste definisali udaljeni sajt, otvara se odgovarajuéi prozor Site Definition.

- Dugme Osvezi (Refresh) nanovo ispituje i prikazuje sadrzinu lokalnog i udaljenog
direktorijuma

- Dugme Get Files kopira izabrane datoteke sa udaljenog sajta na lokalni, pri ¢emu
se zateCene kopije briSu. Ako jo$ niste definisali udaljeni sajt ovo dugme necete
modi koristiti.

- Dugme Put Files kopira izabrane datoteke sa lokalnog sajta na udaljeni. Ni ovo
dugme necéete modi koristiti ako niste definisali udaljeni sajt.

- Dugme Check Out Files (preuzmi i zaklju€aj datoteke), prenosi kopiju datoteka sa
udaljenog servera na lokalni sajt, pri ¢emu se zateCene kopije briSu. Originali
datoteka na serveru zaklju€avaju se. Ovo olakSava timski rad na sajtu. Vi i vase
kolege moZete slobodno preuzimati datoteke sa servera, menjati ih i vracati nazad
na server. Automatsko zaklju¢avanije i otklju¢avanje datoteka Cini da svi mogu da
vide koje datoteke su preuzete radi izmena, zbog €ega ih drugi koji rade na
razvoju sajta ne mogu istovremeno menjati.

- Dugme Check In Files (po3alji i odklju¢aj), prenosi kopiju datoteka sa lokalnog
sajta na server, pri ¢emu se prenesene datoteke na serveru otklju¢avaju i Cine
dostupnim za menjanje.

Napomena: Opcije Check In i Check Out za pojedine sajtove moZete omoguditi ili zabraniti
prilikom njihovog definisanja (u prozoru Site Definition opcija Enable file Check In and
Check Out).

Dreamweaver poseduje i ugradeni program za rad sa datotekama koji dosta olakSava
pristup datotekama koje mogu biti smesStene i izvan lokalnog korenskog direktorijuma
(direktorijum sajta). U desnom okviru prozora Site (Local View) postoji ikonica Desktop
koja omogucéava direktan pristup svim direktorijumima i datotekama na ra¢unaru i njihovo
prevlacenje (kopiranje) u lokalni korenski direktorijum i obrnuto. Prevladenje datoteka sajta
(iz lokalnog korenskog direktorijuma) na ikonicu Desktop, i obrnuto, mora biti obavljeno u
Dreamweaverovom prozoru Site, a nikako u Windows Exploreru ili prozoru My Computer.
Kada dva puta kliknete na datoteke u prozoru Site otvara ih program koji je njihovom tipu
pridruzen u Dreamweaveru. Promenu programa pridruZzenog odredenom tipu datoteka
vrSite izborom opcije Preferences menija Edit u kategoriji File Types/Editors.

Nove direktorijume i strane moZete direktno da pravite u prozoru Site.Tako mozete brzo da
napravite celokupnu strukturu strana i direktorijuma sajta, tako Sto ¢ete napraviti prazne
strane koje ¢e rezervisati mesto u strukturi, a kasnije ¢ete se vratiti i dodati im sadrzinu.
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Kada u desnom okviru prozora Site kliknete desnim tasterom na neki objekat lokalnog
korenskog direktorijuma otvarate kontekstni meni sa brojnim Dreamweaverovim
funkcijama (ove opcije se menjaju u =zavisnosti od izabranog objekta; strana,
direktorijum...). Tako mozete napraviti novu stranu izborom opcije New File. Pojavi¢e se
nova, bezimena datoteka (strana) kojoj treba dati ime (npr. strana3.htm) i pritisnuti Enter
(slika 11.1.3).

) Kontekstni
Desni meni ( izbor Nova
'klik' opcije New (beZimena)
File) strana

il stranal.btm

. el@ stranaz.htm @ [stranaz.htm _

kB crbibecbowe ke | New Folder '
Open ' o
Cpen with 3

Slika 11.1.3 Izrada nove strane u Site prikazu

11.2 Mapa sajta

Mapa sajta vizuelno predstavlja izabrani deo sajta. Na njoj se ne prikazuju svi dokumenti
sajta, ve¢ ona pocinje od strane koja je definisana kao poc€etna strana sajta (Home Page) i
prikazuje sve ostale strane s kojima je poCetna strana povezana linkovima. Prikazuju se
sve strane u hijerarhiji linkova dok se ne dode do 'slepe ulice', {j. strane koja ne sadrzi
linkove. Ako na sajtu imate 'siroci¢e’, tj. strane do kojih se ne moze doci direktnim putem
od poCetne strane, one se nece videti na mapi sajta.

Pre pravljenja mape sajta neophodno je da napravite pocetnu stranu (Home Page) sajta
da bi mapa imala pocetnu tacku. U okviru lokalnih datoteka (desna strana prikaza Site)
izaberite stranu koja ¢e vam biti podetna (Home Page), pritisnite desni taster i u
kontekstnom meniju izaberite opciju Set As Home Page. Ova strana je sada Home Page.
Pocetne strane se obi¢no nazivaju Index.html, jer browseri podrazumevano prikazuju tako
nazvanu stranu ako im nije zadato drukgdije.

Da bi formirali (videli) mapu pritisnite dugme mape sajta (Site map) na paleti alatki prozora
Site i u podmeniju izaberite opciju Map Only (opcija Map and Files daje mapu sa leve i
lokalni korenski direktorijum sa desne strane). Mapa sajta (slika 11.2.1) vizuelno
predstavlja sajt; poCetna strana se prikazuje na vrhu hijerarhije mape. Linkovi od jedne do
drugih strana prikazuju se linijom koja pocinje na strani koja sadrzi link, a strelice na kraju
pokazuju na svaku povezanu stranu. Kad se pritisne znak (+) prikazuju se strane na koje
link pokazuje. | te strane imaju znak plus ukoliko i one poseduju link. Neispravni linkovi
(koji pokazuju na nepostojecée strane) prikazuju se crvenom bojom. Spoljni linkovi, kao to
su adrese za slanje Email-a i URL adrese, prikazuju se plavom bojom i s malom kuglom s
desne strane.
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Traka za kretanje
po strukturi sajta

Files Edit- Yiew. Sites
E P [sefoe /S FaC|8 1 & 8T

ite Mavigation: @ index.html

indez_html

CC

¢+ drugastrana_html - treezastrana_html ;- preastrana_html
Evg)  mapahtml vz bibliotekahtml [Frigl  Skup ckuira html
* b Aktivnopodrugje.. kg azsetshiml

+>d zamenskaslikah..

Slika 11.2.1 Mapa sajta

Mapa se podrazumevano prikazuje horizontalno. Ako pocetna strana ima mnogo linkova,
mozda u prozoru Site nece biti dovoljno masta za prikazivanje svih tih strana istovremeno.
Omoguceno je menjanje broja kolona i Sirine kolona kako bi sve strane sajta stale u jedan
prozor; isto tako mozete promeniti nacin prikazivanja mape na vertikalni. Te promene se
vrSe u prozoru Site Definition u kategoriji Site Map Layout (u prozoru Site izaberite View >
Layout).

Mapu sajta mozete snimiti kao sliku (formati BMP ili PNG) opcijom File > Save Site Map.
Kako sajt bude rastao i postajao sve slozZeniji, njegova mapa moze postati prevelika za
prikazivanje u prozoru Site. Tada mozete promeniti mapu tako da ona prikazuje samo
Zeljenu stranu i strane na koje pokazuju njeni linkovi. To se radi tako $to oznacite tu stranu
i izaberete opciju View As Root menija View. Ispod paleti alatki prozora Site, prikazuje se
siva traka sa hijerarhijom sajta (slika 11.2.1). Hijerarhija poCinje stranom koju ste odredili
za pocetnu (Home Page) a zavr8ava se stranom koju ste zadali za korensku. Ako ste npr.
kao korensku izabrali stranu mapa.html (slika 11.2.1) onda ¢e traka izgledati ovako:

Site Mavigation: @ index.html == @ drugastrana.html =@ mapa. html

Ako Zelite da mapa ponovo prikazuje Home Page na prvom nivou, jednostavno kliknite na
nju u traci.

Mozete takde da kontroliSete koje ¢e se strane prikazivati na mapi sajta i da sakrijete
odredene strane. Strane su sakrivene samo na mapi, a vide se u spisku lokalnih datoteka
u koloni Local Files (kada je izabrana opcija Map and Files). Da bi sakrili stranu pritisnite
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desni taster miSa na nju i izaberite opciju Show/Hide Link. Ona nestaje sa mape. Ako zelite
kasnije da vidite skrivene strane izaberite Show Files Marked As Hidden u meniju View.
Sada se one prikazuju kosim slovima (ltalic). Sada mozete iskljuciti sakrivanje strana
ponovnim izborom opcije Show/Hide Link.

Koris¢enjem mape mozete da dodajete, briSete i menjate linkove. Kad selektujete neku
stranu na mapi pored nje se pokazuje ikonica Point to File. Nju mozete da prevucete do
strane sa kojom Zelite da napravite link, a koja se nalazi u koloni Local Files. Kada pustite
taster miSa link je napravljen.

Dok premestate pokazivaC po stranama (preko imena, a ne preko ikonice) na mapi sajta
na statusnoj traci prozora Site pikazuje se naslov, veli¢ina i datum kada je strana
napravljena. Ako ste zaboravili da date naslov strani, ili hocete da ga promenite, to mozete
uraditi tako $to u meniju View izaberete opciju Show Page Titles, da bi se na mapi sajta
prikazala imena strana umesto imena njihovih datoteka. Stranu kojoj zelite da promenite
ime pritisnite jednom, a posle nekoliko trenutaka jo$ jednom, zatim upiSite novo ime i
pritisnite Enter. Ponovnim izborom opcije Show Page Titles menija View opet se na mapi
pokazuju imena datoteka strana a ne samih strana.

Prilikom promene imena datoteke strane otvara se prozor Update Files u kome ¢e se
prikazati sve strane na koje uti€e ova promena, i pritiskom na dugme Update aZurirate sve
ove strane. Ovo je najbolji nacin promene imena datoteka strana jer Dreamweaver tada
automatski menja sve linkove ka toj strani.

11.3 Postavljanje sajta na server

Da bi posetioci mogli da vide va$ sajt morate ga kopirati na udaljenu lokaciju, tj. na Web
server. Konfigurisanje za to slanje se obavlja u prozoru Site Definition do koga dolazite
izborom opcije Edit Sites menija Site (u prozoru Edit Sites oznacite zeljeni sajt i kliknete
Edit). U prozoru Site Definition treba izabrati karticu Advanced, a u kategoriji Remote info u
polju Access Local/Network jer ¢emo simulirati udaljenu FTP (File Transfer Protocol),
lokaciju. Tako ¢ete moci da eksperimentiSete sa funkcijama Get i Put, kao i drugim
funkcijama za odrzavanije sajta, a da ne morate zaista da se povezujete sa serverom.

Napomena: FTP je uobiCajeni protokol za slanje i preuzimanje datoteka sajta sa servera.
Ako bi u polju Access izabrali FTP, pojavljuju se parametri za Cije pravilno definisanje treba
da se posavetujete sa davaocem usluge servera na kojem ¢ée biti vas sajt:
- FTP Host, ime web servera na kome ¢e se izvrSavati sajt (npr. ftp://mojsajt.com),
- Host Directory, direktorijum na serveru u kome se ¢uvaju dokumenti sajtova,
- Login and Password, vase korisni¢ko ime i lozinka na serveru,
- Use Passive FTP, koristi se kada postoji barijera izmedu vaseg racunara i servera
(ova opcija je podrazumevano nepotvrdena),
- Use Firewall (in Preferences), koristi se ako pri izlasku iz lokalne mreze na putu
do servera prolazite kroz Firewall (ova opcija je podrazumevano nepotvrdena).

Pritisnite ikonicu desno od polja Remote Folder i u prozoru Choose Remote Folder
izaberite folder koji ¢e biti korenski direktorijum vaseg sajta i koji ¢e sluZiti kao zamena za
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server. Ovaj direktorijum mora biti izvan lokalnog korenskog direktorijuma. Pritisnite OK i
Done da bi zatvorili prozor Edit Sites.

Pomocéu Dreamweavera mozete da proverite koje su datoteke lokalnog sajta novije od
odgovarajuc¢ih datoteka na serveru. Tako mozZete da azurirate samo one koje su bile
izmenjene. U meniju Site prozora Site izaberite opciju Synchronize. Otvori¢e se prozor
Synchronize Files, gde u polju Synchronize izabirate da li Zelite da uporedite i aZurirate
samo odredene (selektovane) datoteke lokalnog sajta ili celi sajt, a u polju Direction da li
Zelite da novije datoteke postavite na server ili da ih preuzmete sa servera (slika 11.3.1).

Synchronize Files IE

Synchronize: | Selected Femate Files Ornly v Fresview. ..

Direction; | Put nesver files to remate ¥ Cancel

Put newer filez to remaote
Get newer files from remote k
[ ] Delete rer G et and Put newer files

Help

Slika 11.3.1 Poredenje i azuriranje datoteka sajta

Kada pritisnete dugme Preview... Dreamweaver ¢e uporediti sve datoteke (ili samo
izabrane) direktorijuma lokalnog sajta (desna strana prozora Site) sa onima u direktorijumu
na serveru. Ako oba direktorijuma sadrZe datoteke istih imena, Dreamweaver ¢e uporediti
datume njihovih poslednjih izmena. Ako ste, na primer, zadali akciju Put newer Files to
remote, u direktorijum na serveru se prenose sve datoteke lokalnog direktorijuma kojih
nema na serveru ili su novieg datuma od tamo zateCenih. Kada program zavrsi
pretrazivanje lokalnog i direktorijuma na serveru, prikazace se spisak datoteka za koje je
utvrdio da ih treba poslati na server. U ovom prozoru (slika 11.3.2) se inaCe prikazuju
akcije koje ¢e biti preduzete, imena datoteka i njihov status. Za svaku datoteku mozete da
uklonite potvrdu iz polja akcije i tako naznacite Dreamweaveru da je preskoéi. | ako je
potvrdena opcija Check In / Out funkcija sinhronizacije neée moéi ni da otklju¢a ni da
zaklju€a datoteke.

Unchecked Files will nok be processed.

Action File Status 2

I Put @ Aletivnopodrucie. hitml zkip

' Put a aszzets. html

v Put 5] biblicteka. kil

' Put a Drovunload. hitml

™ Pt @ drugasztrana.html

[+ Put Ll fort kil

W Put @ index. html ||
Filez: 14 will be updated, 1 will be skipped

[ ok ] [ Cancel ] [ Help
Unchecked Files will nok be processed.

Slika 11.3.2
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Pritisnite OK, sinhronizacija ¢e se zavrsiti, i prikazate se izveStaj o ukupnom broju
azuriranih datoteka. Mozete zatvoriti ovaj izvesta;, ili ga sacuvati pritiskom na dugme Save
Log.

Promenjene datoteke lokalnog sajta mozete pronacéi opcijom Select Newer Local menija
Edit u prozoru Site. Dreamweaver poredi datume izmena svih lokalnih datoteka sa
odgovaraju¢im podacima sa servera i bira samo novije lokalne datoteke. Da bi poslali te
novije (promenjene) datoteke na server pritisnite dugme Put Files na paleti alatki prozora
Site. Otvorice se prozor Dependent Files koji pita da li Zelite da poSaljete i zavisne
datoteke (slike...). Yes 3alje na server sve slike na izabranim stranama i HTML kod tih
strana. Opcija No Salje samo HTML kod. Ako ste izmenili samo HTML stranu, a slike su
veé na serveru, nema razloga da ih tamo ponovo Saljete, pa izaberite opciju No. Ako ste
izmenili neku sliku na strani ili dodali novu, izaberite Yes.

Mozete da sakrijete odredene direktorijume ili tipove datoteka i tako ih iskljucite iz dosega
funkcija Synchronize, Get, Put i Check In/Out. Skriveni direktorijumi i tipovi datoteka
isklju€eni su i iz operacija koje pokrivaju celi sajt, kao Sto su biranje novih lokalnih i
dokumenata sa servera, provera linkova, pretrazivanje i zamena, izvestaji i aZuriranje
biblioteka i Sablona. Skriveni direktorijumi i tipovi datoteka ne prikazuju se u spiskovima
panela Assets. Sakrivanje i otkrivanje pojedinih direktorijuma i datoteka vrsite tako Sto ih
oznacite i izaberete opciju Site > Cloacking > (Un)cloak. Ako izaberete Site Cloaking
Settings otvara se kartica Advanced prozora Site Definition sa izabranom kategorijom
Cloaking gde mozete onemoguciti skrivanje za celi sajt tako $to cete ukloniti znak potvrde
iz polja Enable Cloaking. U polje Cloak Files Ending With mozete upisati ekstenzije za
tipove datoteka koje Zelite da sakrijete na celom sajtu (npr: .pdf . fla.). Skriveni direktorijumi
i datoteke su precrtani crvenom linijom.

- 69 -



Macromedia - Dreamweaver MX

Literatura

Dreamweaver MX Tutorial, http://www.macromedia.com/software/dreamweaver/,
Macromedia Dreamweaver MX iz prve ruke, Khristine Annwn Page, Mikro Knjiga 2002.

-70 -



	SADRŽAJ
	Upoznavanje sa Dreamweaver MX-om
	1.1  Šta je Dreamweaver i njegova osnovna namena
	1.2   Radna površina i alati

	Kreiranje Web sajta i Web strane
	2.1    Kreiranje lokalnog Web sajta
	2.2  Kreiranje nove Web strane
	2.3  Zadavanje Web Browsera

	Rad sa tekstom
	3.1 Upisivanje i formatiranje teksta
	3.2    Rad sa fontom
	3.3 HTML i CSS stilovi
	3.4 Specijani znakovi, horizontalne linije, datum

	Rad sa grafikom
	4.1  Postavljanje slike na stranu
	4.2  Menjanje velicine slike i njeno pozicioniranje
	4.3 Davanje imena i HTML oznaka <alt> slikama
	4.4  Panel Assets i Flash dugme

	Dizajniranje Web strana
	5.1 Kreiranje tabela u Layout i Standard prikazu
	5.2  Promena svojstava i elemenata tabele
	5.3.  Ugnježdavanje tabela i pravljenje okvira

	Hiperveze (linkovi)
	6.1 Pravljenje tekstualnih i grafickih hiperveza
	6.2  Umetanje sidara i povezivanje sa njima
	6.3  Mapirane slike

	Izrada interaktivnih strana
	7.1  Rollover Image
	7.2 Otvaranje novog prozora browsera
	7.3   Iskacuci (Pop-Up) meni

	Rad sa bibliotekom
	8.1 Pravljenje i postavljanje elemenata biblioteke
	8.2   Menjanje elemenata biblioteke
	8.3  Pravljenje i menjanje elemenata biblioteke k

	Izrada okvira
	9.1  Skup okvira
	9.2  Karakteristike okvira i skupa okvira
	9.3  Sadržina okvira i traka za navigaciju

	Korišcenje šablona \(Templates\)
	10.1 Pravljenje Template-a
	10.2  Ažuriranje sajta pomocu Template-a

	Održavanje Web sajta
	11.1  Održavanje sajta u Site prikazu
	11.2  Mapa sajta
	11.3 Postavljanje sajta na server

	Literatura

